
Elements+ Setup

"Elements+" (hereinafter, "E+") is an add-on that
powers up Adobe Photoshop Elements (hereinafter,
"PSE").

For placing all the necessary files on your computer
just run the E+ installer (elements+2024.exe) and
follow its instructions. The first PSE launch after the
E+ setup usually takes several minutes, because the
application has to rebuild its cache file.

Thereafter, you can find the E+ features in the PSE
Editor's "File > Automation Tools" menu.

For example, "File > Automation Tools > E+
Layers", "File > Automation Tools > E+ Scripts",
etc..

If you prefer graphic icons:

1. Go to the "Effects" palette (Window >
Effects).

2. In the upper menu, select the "Classic"
option.

3. In the lower menu, choose the
"Elements+" category (fig. 1).

Another way to use "Elements+":

1. Open the Actions panel (Window >
Actions).

2. In the palette menu, select "Elements+"
item (fig. 2)

If you can't find "Elements+" item in the flyout
menu:

1. In the same menu, click "Load Actions"
line.

2. Browse to "C:\Elements+\2024\Actions"
folder and choose "Elements+.atn" file.



How Elements+ Works

PSE, just  like  the  Photoshop  full  version,  supports JavaScript
language. It  is  this  ability  which  lets  E+  reach  the  hidden
functions of the application.

The E+ kit includes 11 "main" or "top level" scripts -- Color and
Tone, Selections,  Layers,  Styles,  Masks,  Smart  Filters,  Paths,
Text, Scripts,  RAW Corrections,  and Tool  Presets -- as  well as
dozens of "supplementary" scripts.

You start the  "main"  ones  through  "File >  Automation Tools"
menu, by double-clicking their thumbnails in the Effects palette
(fig. 1), or  by playing  corresponding  actions  (fig.2).  These scripts
are designed for accessing the undocumented PSE features.

The supplementary scripts, intended for some specific tasks, are
to be run from the "Scripts" dialog box (fig. 3).

NB Actually, the difference between the "main" and
"supplementary" scripts is purely conventional, because any of
the "supplementary" ones may be added to the Effects and
Actions panels as well.

By default,  all effects  appear in  the  palette  as thumbnails. To see
the correspondent  script  names,  you  either  hover  the mouse
pointer over  thumbnails  (fig.  1)  or  choose  the  "Show Names"
option from the palette menu.

Please keep in  mind that  the  effects  won't  work unless  an  image
is open in Photoshop Elements. So,  you can't  run an E+ script
until you create or open at least one document.

Besides, PSE doesn't let you apply effects if:
- more than one layer is selected in the Layers palette;
- the color depth of the current image is more than 8 bits;
- its color mode is "Indexed Color" or "Bitmap".

You can  avoid  these  restrictions  with  the  help  of  the Actions
panel (fig. 2).

Your version of Elements+ also provides an alternative method
for launching  the  scripts.  Both,  "main"  and  "supplementary"
scripts can be started from the tray menu.



Using Elements+ from Tray Menu

Launching scripts  from  the  system tray is  yet another handy way
to access Elements+ features.

To load E+ menu into the tray, go to 
"Start > All Programs > Elements+ > Elements+15 Tray Menu".

Alternatively, you  can achieve this  by clicking  this   icon in
"Elements+ Options" dialog.

By default, Windows tends to hide app icons. To keep the menu
icon visible, click "arrow" ^ button and drag the  icon onto the
taskbar.

To access  E+  tools  from  the  tray,  left -click the   icon  and
choose the required script in the menu.

The lower  part  of  the  tray  menu  corresponds  to  "Favorites"
category of the Scripts catalog. The upper items are the categories
containing the rest of the scripts. So called "main" E+ scripts can
be found in "~" category.

To put the most used tools into the "quick-access" area, open the
"Scripts" dialog and add the required scripts to "Favorites".

If the added items don't appear in the menu, right-click on the
E+  icon and apply the "Refresh"  command.

To make  the  tray  icon   load  automatically  when  Windows
starts up,  right-click on  the icon and check  "Load  on Startup"
option.



About Elements+ Dialog Boxes

Dialog boxes  of  the  main  scripts  are a  kind  of additional  palettes,  granting access  to  the  hidden functions of the
application and the features of the document.

The principal part of those dialogs is the Commands panel which is situated on the right side of the dialog boxes as a
rule. To apply a command, you  either  select it in  the  list and  click the "Apply"  button,  or just  double -click the
command's line. For example, on the screenshot 1 you can see the application of the "Define Clipping Path" command.

By default,  the  Commands panel displays only the  applicable commands  and hides those that, for some reason, can't be
used under  the  current  circumstances.  Still,  if  you  decide  that  a  required  function  is  missing  in  the list without
reasonable grounds, you may check the "Show All Commands" box and try to apply the command.

Tip. Optionally, most, though not all, commands may be added straight to your Effects panel.

Alongside with  the  Commands list,  most  dialogs also include  a panel for  feature-specific contents. For example, the left
part of the  Paths  dialog  displays  all the  paths  existing in the document. By  choosing  an  item from this list (in our
example the path named "Cheese" is selected) we activate the corresponding path in the document window.

A script window may be closed in three different ways:

1. If you  click the  "Close"  button  at  the dialog  box  bottom  or  press [Enter]  key,  the script remembers the window
position and "Auto-close" option. BTW, the dialog auto-closure also saves these settings.

2. By clicking  the  system "close"  button or  by pressing  the  [Esc] key you close the  dialog  box without saving your
settings.

3. The supplementary  script  dialogs close with  saving of  the  user-defined parameters  when  you click  the "Run" button.
To save your script settings without applying the script, click the "Save and close"  button.

Please, keep in mind that when you launch a script from the Effects panel, all your actions from opening till closing the
script's dialog are saved in your Undo History palette as a single history state. As result, you can undo just a part of your
recent operations. You have to undo either all the steps at once or none. For a script launched from the tray menu, PSE
remembers every command as a separate history state.



Choosing Elements+ Interface Language

To change language in E+ dialogs:

1. In the Effects palette, double-click the "Scripts"
thumbnail.

2. In  the  "Scripts"  dialog  box  that  appears,
double-click the  "E+ Options"  item (fig.  1)  to  open  the  E+
settings dialog.

3. In  the  "Elements+  Options"  box,  choose a  language from
the pulldown menu (fig. 2).

5. Click "OK" to apply the changes.



Adding E+ Commands to the Actions Panel

By default, we access the Elements+ features via its main
dialogs. It is strongly recommended, though, to add the most
often used commands and scripts directly to your Actions
panel.

1. In the Actions palette menu, select "Load Actions" item
(fig. 1).

2. For adding into the Actions a command from a E+ dialog,
browse to "C:\Elements+\15.0\Actions" folder and choose the
corresponding action set. For example, if you need some color
correction commands load the "Color and Tone" set.

3. To load a script from the E+ catalog, browse to
"C:\Elements+\15.0\Actions\Scripts" and choose the required
action set. For example, to access focusing scripts, choose
"Sharpen" set.

4. To avoid clattering the panel, delete  the actions that you
don't plan to use often (fig. 2).

As result you get a compact kit perfectly fitting your everyday
tasks and working habits.

5. Now to access a E+ feature, just play  the corresponding
action (fig. 3).



Adding E+ Commands to the Effects Panel

The Effects panel also let us directly access the most helpful commands and scripts without opening the main Elements+ windows.

1. For adding  tho  the Effects  a command from a E+ dialog,  open  the  proper  dialog  window,  choose the wanted item in the
Commands panel,  and click  the  button (if this  button isn't  available,  the  selected  command can't  be added  to the Effects). The
screenshot 1 exemplifies adding the "Soft Proof" effect.

2. To add a script from the E+ catalog, open the "Scripts" dialog, select the required item in the list and click the  button. On the
screenshot 2, you can see adding to the Effects "Multi-Export" script.

3. In the  dialog  that  opens,  edit  if  necessary the  name that  must  be displayed in  the  Effects palette. In the screenshot 3, the "Soft
Proof" command has been renamed "Digitalproof".

 

4. Also, in the "Category" menu you can choose a destination tab for the  added effect. To create a  new one, choose the "New
Category..." item and enter the desired name in the text field that appears (fig. 4).

5. Now to make the added commands appear in the Effects panel:

Exit Photoshop Elements
Find the PSE localization folder
Delete the "MediaDatabase.db3" (PSE cache-file)
Restart Photoshop Elements and wait several minutes while the program recreates its cache file.

Tip. If you can't find the cache-file, launch the "fx Commander" script and apply the "Reveal MediaDatabase" command.

6. In the  Effects  palette, open the  "Photo  Effects"  tab  and,  from  the  drop menu, choose the category the added command belongs
to.

7. Apply the command by double-clicking its thumbnail (fig. 5).



Exporting E+ Commands to the Scripts Catalog

Apart from  putting  the  E+ commands  onto  the  Effects panel,  you  can  export  them  to the Scripts catalog. Then the
created scripts can be used individually, batch-played, and/or concatenated to new command sequences.

1. Open the proper dialog window, choose the wanted item in the Commands panel, and  click the  button (if this
button isn't available, the selected command can't be exported).

The screenshot 1 exemplifies exporting the "Create New Group" effect.

2. In  the  dialog  that opens, edit, if  necessary, the name that  must  be  displayed  in  the  Scripts dialog and choose a
destination category. To create a new one, choose the "New Category..." item and enter the desired name in the text field
that appears (fig. 2).

3. To use the created script, just open the Scripts dialog, go to the appropriate directory and double-click the desired
script name (fig. 3).



 

Droplets

"Droplets" provide a quick and

intuitive way to apply scripts to pictures. You just
drag one or more image files onto the droplet icon
and... it's done! (fig. 0)

If you like such an approach let's discuss it in
more detail.

1. First, you have to create a script-based droplet:
- Select a script in the E+ catalog and click the
"droplet"-button (fig. 1/1), 
- in the dialog that opens, define what to do with
the edited images -- either save to a specified
location or not to save and leave the documents
opened in PSE Editor (fig. 1/2),
- press "Create" button, choose target directory
and specify the droplet name (fig. 1/3).

2. Many scripts in the E+ catalog open dialogs for
modifying user settings. To create a droplet from
such a script, use the "droplet"-button at the
dialog bottom (fig. 2).

The created droplet remembers the current
settings and, later on, applies those without
opening any dialogs. If necessary, you can make
several droplets based on a single script, with
different settings for different tasks.

 

 

 

 

 

 

 

 

 

 



3. Some scripts of the E+ catalog create a new document
from multiple images. Droplets based on such scripts inherit
the same logic.

For example, by dropping several files onto "File Piler"
droplet we combine them in a single document as layers.

Other scripts of this kind:
- Filmstrip All,
- Focus Stacking,
- Noise Stacking,
- Star Trails.

4. To apply the created droplet, browse to it in the
"Windows Explorer". Then, in the same or a different
"Explorer" window, select one or more image files and drag
them onto the droplet (fig. 0).

To process all the files in a specific directory, drag and drop
the whole folder (fig. 4).

Important! Please, note that the Elements+ droplets are not
portable. I.e., running a created droplet on a different
computer is impossible.



Troubleshooting (Windows)

I. In case Elements+ thumbnails don't appear in the Effects panel:

1. Close Photoshop Elements.

2. Uninstall Elements+.

3. Locate on your computer the Photoshop Elements application data folder. 
The default path is C:\ProgramData\Adobe\Photoshop Elements\15.0

Tip. To find this folder, you may need to show hidden items.

4. Run the "Elements+" setup and specify the correct path to the Photoshop Elements program folder.

5. In the  PSE  data  folder, go to  "Locale > your_localization*" subfolder and make  sure "MediaDatabase.db3"
(Elements' cache file) is deleted.

*This subdirectory should be named after PSE language - e.g., "en_US" for US English, "de_DE" for German,
"fr_FR" for French, etc.

6. Restart Photoshop Elements (after deleting the program cache it may take several minutes).

II. In most cases when Photoshop Elements is not working properly, it is necessary to reset the program settings. To
achieve this,  you  hold  the  [Alt+Ctrl+Shift]  keys  while  launching  the  PSE  Editor  (not  the  Welcome  Screen or the
Organizer) and then in the dialog that opens, confirm deleting the settings file.

III. In some rather rare  cases,  PSE crashes during  the  first  launch after the E+ setup, thus failing to complete the cache
rebuilding. This may  cause  the  application  to  crash  over  and  over again.  To amend this,  just  delete the  defective
"MediaDatabase.db3" file (see p. I.5) and reset the PSE settings (see p. II).

IV. Some  users  report that,  after successful E+ setup, launching  any of  the  top level  scripts ends with a "window error"
message. Furthermore, in some cases, the script dialogs may freeze or crash PSE Editor.

 

Unfortunately, this is a known issue with the Adobe's script engine and the total remedy hasn't been found yet. If the
problem doesn't resolve itself after several computer re-boots, consider the "dialogless" approach to Elements+ usage.

That is, you run the commands right from your Actions panel without opening any extra dialogs. 
Another solution is running E+ scripts from the system tray.



    Troubleshooting Elements+ (Mac)

       I. In case the automatic installer doesn't work for you, please setup E+ manually as follows:

1. Mount Elements+ disk image (i.e., open "elements+15.dmg" file).

2. In your "Applications" folder, create "Elements+" subfolder and copy to it the "stuff > 15.0" folder from the E+
disk image (fig. 1).

 

3. In PSE Editor, open the Actions panel (Window > Actions), in the panel fly out menu, choose "Load Actions" item,
browse to "Applications > Elements+ > 15.0 > Actions > en" folder and load "Elements+.atn" file. Now absolutely all
Elements+ features can be accessed through the actions (fig. 2).

4. To add Elements+ tools to "File > Automation Tools" menu, go to "E+ DMG > stuff > Menu > en" and copy all the
JSX files to "Macintosh HD > Applications > Adobe Photoshop Elements 15 > Support Files > Presets > Scripts".

If you are happy with the above E+ access methods, consider the setup complete.

However, if you prefer the icons in the Effects panel, you have to accomplish several more steps.

5. From the "Elements+" disk image, copy the contents of "stuff > Thumbnails" folder into "Macintosh HD > Library
> Application Support > Adobe > Photoshop Elements > 15.0 > Photo Creations > photo effects" folder (fig. 3).



 

6. Go to "Macintosh HD > Library > Application Support > Adobe > Photoshop Elements > 15.0 > Locale > en_US"*
folder, delete "MediaDatabase.db3" file (fig. 4), and restart Photoshop Elements.

*This subdirectory should be named after your PSE localization - e.g., "en_US" for US English, "de_DE" for
German, "fr_FR" for French, etc..

II. In most cases when Photoshop Elements is not working properly, it is necessary to reset the program settings. 
To achieve this, you hold the [Opt+Cmd+Shift] keys while launching the PSE Editor (not the Welcome Screen or the 
Organizer) and then in the dialog that opens, confirm deleting the settings file.

III. In some rather rare cases, PSE crashes during the first launch after the E+ setup, thus failing to complete the 
cache rebuilding. This  may  cause  the  application  to  crash  over  and  over  again.  To  amend  this,  just delete the 
defective "MediaDatabase.db3" file (see p. I.5) and reset the PSE settings (see p. II).

IV. Sometimes, after seemingly successful E+install, launching any script results in "JavaScript was missing" message:

As a rule, this error means the automatic installer couldn't copy the scripts and other required files to your HD. 
Please, copy them manually as described in p. I.2.



Removing Elements+

If you need to remove Elements+ from your PC:

1. Quit Photoshop Elements.

2. Go to "Start > All Programs > Elements+ > Uninstall Elements+ for PSE 15".

3. In the dialog that opens, confirm removing the application.

To remove Elements+ from a Mac:

1. In the Effects palette, double-click the "Scripts" thumbnail.

2. In the  "Scripts"  dialog  box that  appears,  double -click the  "E+  Options" item to open
the E+ settings dialog.

3. In the "Elements+ Options" box, click "Uninstall Elements+" button.

Please note that the E+ uninstaller automatically deletes the Photoshop Elements cache file, so
the next launch of the program may take several minutes.

If you wish to do without rebuilding the cache, just delete the Elements+ thumbnails in the
Effects panel as shown on the screenshot:



Color and Tone

You open the "Color and Tone" script's
window by double-clicking its thumbnail
in the Effects palette.

Also, if "Elements+" set is loaded to your
Actions panel, you can call "Color and

Tone" dialog by pressing [F2] key.

The panel on the right side of the dialog displays the
applicable commands.

The Channels panel on the left side allows us to select
and edit color channels individually.

When working with large files the "Color & Tone"
dialog may open very slow. To speed up the script
check the "Turbo"gadget at the dialog bottom.

Since in the "turbo" mode, the left panel is disabled,
there appear several channel selecting commands in
the right panel.



Curves

"Curves" is the most powerful adjustment command in
Photoshop. Although its functionality and work
principles are very similar to those of "Levels", this

method lets us edit virtually any tonal range, or even adjust
several different ranges in different ways.

So, how to adjust the image tone:

1. For a layered document, select the front (uppermost) layer
in the Layers palette.

2. Apply the "Curves"  command.

A dialog box will appear allowing you to adjust image tone by
editing the graph. Generally speaking, the sharper your graph
is the more contrasting the image will be.

3. Very carefully pull some middle point of the graph to
brighten or darken the image midtones.

4. Pull the graph at some lower point rightward to decrease
brightness in the darker areas (let's say, in "mid-shadows").

5. Uplift the upper segment to brighten the "mid-highlights".

6. To define tonal range more precisely, [Ctrl]-click a specific
spot on the image. Then pull the graph at the added point to
adjust the selected range.

7. Click "OK" to apply the correction.

If you need to modify the created adjustment layer's settings
use Edit Adjustment Layer command.



Color Balance

"Color Balance" is one of the most helpful color
adjustment tools.

1. If the edited document is layered select the uppermost layer
in the Layers panel.

2. Apply the "Color Balance" command.

There appears dialog box allowing you to redistribute image
color. The logic of this tool is based on RGB color model. That
is, by adding a primary - red, green, or blue - color, you reduce
amount of its complementary - cyan, magenta, or yellow -
color. And vice versa.

3. For example, to remove yellow color cast, you move the
lowest slider "blue'ward"; to decrease cyan, you move the
uppermost slider "red'ward".

NB If the sliders "stick" to the cursor, don't move it during a
second after releasing the mouse button.

4. The radio-buttons under the sliders let you restrict edited
tonal range. For instance, you can try to add some yellow in
the image shadows and decrease this color in the highlights.

5. Click "OK" to apply your adjustment.

If you need to modify the created adjustment layer's settings
use "Edit Adjustment Layer" command.



Black and White

Although PSE comes to us with a special command for
converting color pictures to B&W (Enhance > Convert to
Black and White), this tool is a substantially simplified

substitute for its Photoshop analogue. And what's even worse, it
can only adjust the current layer and not the composite image
underneath.

The "Black and White" command lets you apply the Photoshop
version of the tool as a separate adjustment layer.

1. Open a color image.

2. Run the "Color and Tone" script and apply the  "Black and
White" command. Then in "New Layer" box, click "OK" to
proceed to the "B&W" tool.

3. In the "Black and White" dialog that opens, you can
redistribute luminance by specifying how the original colors
influence the resulting monochrome image. For example, by
reducing the percentage of "Yellows" you make a (formerly)
yellow color range darker. On the contrary, by increasing the
amount of a color you lighten the corresponding areas.

4. If you wish to tinge the made black & white picture, check the
"Tint" gadget. By default, the dialog offers a kind of "sepia" effect.
However, you may change the image hue and / or saturation as
needed.

5. When ready, click "OK" to apply the effect. The adjustment
appears in the Layers palette as a separate layer.

6. And what does this adjustment layer give? At any time you can
hide / show a B&W effect by toggling the layer visibility or fine-
tune its strength by reducing the layer opacity.

7. By default, all created adjustment layers have a layer mask. So,
if you want to restore color in a certain spot of your B&W image,
just paint over the mask with black color or select and fill the
required area.

If you need to modify the created adjustment layer's settings use
"Edit Adjustment Layer" command.



Exposure

The "Exposure"  tool has been created  for editing  HDR photos.
Still it  may  be  also  used  for  tonal correction  of  ordinary 8-bit
images.

1. Open the "Color and Tone" dialog.

2. Apply the "Exposure"  command.

The dialog  box  that  appears  suggests  adjusting  the image tone
with 3 sliders.

3. The "Exposure" slider mainly affects the image highlights.

4. The "Offset" parameter darkens the midtones and shadows.

5. At last, the "Gamma" slider adjusts the image gamma.

6. Click "OK" to apply the correction.

The adjustment appears in the Layers palette as a separate layer. So, you
can mask unnecessary areas, reduce its opacity, etc..

Unfortunately, PSE won't let you to re-open the "Exposure" dialog and
edit the adjustment settings.

Vibrance

The "Vibrance" tool serves for fine-tuning the image saturation.

1. Open a color image

2. Run the "Color and Tone" script and apply the "Vibrance" 
command.

In the dialog box that appears you may adjust the saturation in
two different ways.

3. The "Saturation"  slider  equally  increases  or  decreases
saturation of every pixel in your image.

4. The "Vibrance" slider works more selectively. It increases the
saturation of less saturated pixels more than the pixels that are
already saturated.

For example, on the screenshot, increasing the "vibrance" value
saturates the sky  without  significantly  affecting the rest  of the
photograph.

5. When ready, click "OK".

The adjustment appears in the Layers palette as a separate layer. So, you
can mask unnecessary areas or reduce its opacity. If you need to modify
the its settings use "Edit Adjustment Layer" command.



Channel Mixer

The "Channel Mixer" command lets you adjust an image by re-
mixing its color channels. To use it efficiently, bear in mind the
three sets  of  complementary  colors:  "Cyan -  Red", "Magenta  -

Green", and "Yellow - Blue".

1. In case the edited image is layered, select the uppermost layer.

2. Apply the "Channel Mixer" command.

3. If you  haven't  used  "Channel  Mixer"  previously,  begin with
testing the  effects  available  in the "Preset"  menu. Just to get a
general idea  what  this  tool  is  about.  In  the  example  on  the
screenshot, "Duochrome Blue-Yellow" preset is used as a starting
point for further corrections.

4. To use  your  own  adjustment  settings,  select  the  proper
channel in  the  "Output Channel"  drop  menu. For example,  to
alter the blue-to-yellow ratio, you select the "Blue" channel.

5. Try to  adjust  color with  the  "Source Channels" sliders, keeping
your eye on "Total" percentage. For example, to fix a blue cast,
you reduce this value; to remove yellow, you push it over 100%.

The "Channel  Mixer"  is  also  a  great  tool  for  Black  &  White
conversions:

6. At the  bottom  of  the  dialog  box  that  appears,  check  the
"Monochrome" option. The image turns grayscale.

7. Redistribute luminance with "Red", "Green", "Blue" sliders to
achieve the best possible tone and detail.

8. If you  want  to  colorize  the  grayscale  image,  uncheck  the
"Monochrome" gadget, in the "Output Channel" menu choose one
of the color channels, and play with the color sliders.

Once the "Channel Mixer" dialog is closed, your correction appears in
the Layers panel as a separate layer.

If you need to modify the created adjustment layer's settings use "Edit
Adjustment Layer" command.



Color Lookup

Although the  term  "color  lookup  tables"  may  sound
intimidating, on practice, it means  just  a collection of  cool
one-click effects.

1.  Open  "Color  and  Tone"  dialog  and  run  "Color Lookup"
command. Then in "New Layer" box, click "OK" to proceed to
"Color Lookup" box.

2. In "3DLUT" menu, choose one of the available items.

Since the selected  effect immediately  appears  in  the  image
window, you can test all of them without closing the "Color
Lookup" dialog.

Note: In case your "3DLUT" menu is empty, copy
"C:/Elements+/15.0/Presets/3DLUTs" folder to "C:/Adobe
Photoshop Elements 15/Support Files/Presets" directory.
Then restart PSE.

3. Click "OK" to apply the effect.

The color  lookup  tables  are  always  applied  "as  is".  No  user
interaction is  required.  If  you  don't  like  the  created  effect, just
remove the  "Color  Lookup"  layer  and  create  a  new  one,  with  a
different lookup table.

Elements+ comes  to you  with  17 ready-made 3DLUTs.  Additional
color lookup files may be found on the Net.

Unfortunately, PSE can't create custom lookup tables. To save and
reuse visual effects of your own, please, consider the "Looks" tool.

 



Selective Color

Let's see another method of color correction.

1.  Open a color image.

2. Run the  "Color  and  Tone"  script and apply
the "Selective Color" command.

There appears  a  dialog  box  allowing  you  to  remix
colors for various color ranges.

Although Photoshop Elements doesn't support CMYK
mode, this  tool  relies  on  CMYK  logic  of  color
presentation.

3. Choose the  proper  range  from  "Colors"  menu. For
example, to remove yellow cast, you select "Yellows".

4. Move the sliders to adjust amount of cyan, magenta,
yellow, and/or black process ink.

For example, on the screenshot we fade the green color
by reducing amount of yellow and cyan ink.

5. Click "OK" to apply the changes.

If you need to modify the created adjustment layer's settings
use "Edit Adjustment Layer" command.



Edit Adjustment Layer

Ok, now  that  we  can  create  "undocumented"
adjustment layers,  we may want  to modify their
settings.

Since Photoshop Elements  doesn't  allow to  do it in the
regular way (in the Adjustments panel), use E+ "Edit
Adjustment Layer" command instead.

1. In the  Layers  panel,  select  a  "Curves",
"Channel Mixer",  "Color  Balance",  "Vibrance",
"Black &  White",  or  "Selective  Color"
adjustment layer (screenshot).

*"Color Lookup" and "Exposure" layers are not
editable.

2. Apply the  "Edit  Adjustment  Layer"  

command (either  from  the  Color  and  Tone
dialog or the Actions panel).

3. If "New Layer" dialog opens, click "OK". 
(At this point the adjustment effect disappears,
because the script recreates the edited layer.)

4. Modify the adjustment settings as needed.



Soft Proof

The "Soft  Proof"  utility allows  you  to  preview  how  your
image will  be  output  by  a  particular  device,  such  as  a
monitor, commercial  press,  desktop  printer,  etc.  This

feature doesn't affect the image  file; it only  alters  the  way it is
displayed in the Photoshop Elements window.

1. Open an image of your choice.

2. Call the "Color  and  Tone" dialog  and  double-click the
"Soft Proof"  command  (see  screenshot).  A  "Customize
Proof Condition" dialog box will appear.

Tip. If the Shortcuts+ set is loaded, you can call the "Soft
Proof" by pressing [Shift+Ctrl+P] keys.

3. From the  "Device to  Simulate"  menu,  select  a  profile of
your target output medium. For example, it may be an ICC
file supplied with your ink jet printer.

4. The selected  profiles  allow  further  customizing.  For
example, for  a  printing device  you may simulate real dingy
paper by selecting the "Simulate Paper Color" option.

5. Click "OK" to apply the changes.

6.  If  necessary,  fine  tune  the  image  tone / color to the
target output device.

Tip. For accurate previewing, make sure that your monitor is
calibrated, and the required ICC profile is installed in your
operating system.

The selected profile works just for the current document during
the current session.  You  may assign different profiles  for  each
image opened in Photoshop Elements.



Editing Color Channels Individually

The left  panel  of  the  "Color and Tone"  dialog is  intended  as a
substitute for the  missing  Channels palette.  It lets  you edit the
Red, Green,  and  Blue  color  channels  individually.  To  use  it
efficiently, bear in mind the three sets of complementary colors:
"Cyan - Red", "Magenta - Green", and "Yellow - Blue".

Any tonal  adjustment  of  a  color  channel  alters  the correlation
between its primary  and complementary color.  That is, lightening

a channel  increases  the  amount  of  the  corresponding  primary  (red,
green, or  blue) color,  while darkening  it  adds  the complementary (cyan,
magenta, or yellow) color.

For local color corrections, we may pre-define some area with a selection
tool. Moreover, we can paint on a color channel with white, black and
grayscale colors.  As  a  rule though,  pure lightening and darkening works
much finer.

1. For example, to fix a blue color cast, you choose the Blue
channel (fig. 1). Although the image looks absolutely the
same, only the Blue channel is active at the moment.

2. By default, the script displays the inactive channels too (in our
example, the  Red and Green  ones). In case  you prefer to see only
the active (Blue) channel, uncheck the "Show inactive channels"
checkbox. This option shows the selected channel as a grayscale
image.

3. Now use any tools or commands  to  either  lighten or darken
the selected  channel.  For  example,  on  the  screenshot  2,  we
lighten the  Blue channel  with  the  Dodge   tool  to  color the  eye
blue.

4. If necessary, select and edit another color channel. For
instance, darken Green channel with the Burn  tool to
increase magenta color.

5. After editing  the  color  channels,  open  the  "Color  and
Tone" dialog  once  again  and  select  the  "RGB" channel.
Now you can resume editing of the composite image.

Please keep  in mind that  in  a  layered  document, you  select and edit
color channels only for the current layer. By choosing any other layer,
you automatically switch to the RGB (composite) channel.



Splitting Channels into Separate Images

The "Split  Channels" command divides  the  Red, Green,
and Blue  channels  of  a  RGB  image  into  independent
grayscale documents that can be saved as separate files.

In the  example  shown  in  the  screenshot,  the  color  image
"flower.jpg" has  been  split  to  three  grayscale  images:
"flower.jpg_R" ("_R" stands for "Red channel"),  "flower.jpg_G"
(Green), and "flower.jpg_B" (Blue).

Also, the resulting documents can be edited independently and
then merged into  a color image. The  advantage of this method
compared to  the  channel  selecting  is  that  you can  use  layers and
other advanced editing techniques.

Scrutinizing the resulting grayscale images suggests yet another
application of  this  method. Very often,  one of  the  channels  (as  a
rule, the Green  one)  proves  to contain  the  most  detail  of  the
source image,  the  second (usually,  the  Red) channel provides the
contrast map,  while  the  third (Blue) channel is responsible for
the noise.

This means  that  we  can, for  example, apply  a noise reduction
filter to  the  "blue"  image  "flower.jpg_B"  without  affecting the
detail contained in the "flower.jpg_G" document.

After editing the grayscale "channel" images we can reunite them
into a  new  color  picture  by  using  the  "Merge  Channels"  
command.



Merging Channels

The "Merge  Channels"  command  combines  three
grayscale images into a single RGB document.

You may need this feature for reuniting channels divided with
the  "Split Channels" command.

1. First, make  sure  that  all  the combined  images  are in the
Grayscale mode and their pixel dimensions are the same.

2. Select one of the combined documents and apply the 
"Merge Channels" command (fig. 1).

3. In the  dialog  that  opens,  select  the  RGB* Color  mode  (fig.
2) and click "OK". One more dialog appears.

*CMYK, Lab, and Multichannel modes are not supported in
PSE.

4. Specify the source document for each created color channel
(fig. 3).

In the example in the screenshot 3, the divided channels of
the "flower.jpg" file kind of return their places of origin: the
Red channel to be  created from the "flower.jpg_R", Green
from the  "flower.jpg_G",  and  the  Blue  from  the
"flower.jpg_B".

In the  meantime,  in  some  cases,  you  may  intentionally
misplace the channels to achieve a special visual effect.

NB Please, keep in mind that the "Merge Channels"
command automatically closes the source grayscale images
without saving.



Selections

You call  the  "Selections"  script  by  double-
clicking its thumbnail in the Effects palette.

The Commands panel occupies the right side of
the dialog box.

On the left  side  there  is  a list  of  available color and alpha
channels (the both types may be used for selection purposes).

When working with  large  files  the  "Selections"  dialog may
open very  slow.  To  speed  up  the  script  check  the
"Turbo"gadget at the dialog bottom.

Since in the "turbo"  mode, the  left  panel is disabled,  there
appear several  extra  commands  in  the  right panel for loading
the color channels to selection.



Load Selected Channel

The panel on the  left side  of  the "Selections" dialog displays the
color and alpha-channels (saved selections).

To load any of  those as  selection,  choose  it  in the list and apply
the "Load Selected Channel"  command (see screenshot).

Or just double-click the channel's line in left panel.

The alpha -channels will  be discussed  a bit later. At this time,
let's see why load the color channels.

The Red,  Green,  Blue  and  RGB  channels  let  us  select  the  image
luminosity, that is, its brighter areas. The most often used channel for
the purpose is he composite (RGB or Grayscale)  one.

By double-clicking the uppermost line in the Channels list, you load
the brightest  areas  of  the  RGB  channel,  that  is  "of  the composite
image" or "of  all  visible  layers".  To  ignore  the luminosity of certain
layers, just hide those before applying the effect.

As result,  the  image  areas  get  selected  proportionally  to  their
lightness. (That's how "Hide Luminosity" script works.)

The most  evident  use of this  method  is  extracting line art  from  a
scanned drawing:

1. Open the "Selections" dialog.

2. Select the  drawing  (presumably,  white)  background  by
double-clicking on the RGB channel.

3. Clear or mask the selected area.

On the  contrary,  to  select  darker  areas  of  your  image,  you load
luminosity and then apply the "Invert Selection"  command.

Sometimes, it's the only way to extract, e.g., soft shadows from a light
background (as  a  rule,  the  Magic Wand and Quick Selection tools are
pretty useless for this). A great example of this technique can be found
here.

Furthermore, this B&W conversion method is also based on the image
luminosity selection.

In some  cases,  you  may  want  to select the luminosity  of  an
individual color channel. Again, hide in the Layers palette the
layers you  don’t  need,  and  then  double -click the  "Load Red
Channel", "Load  Green  Channel",  or  "Load  Blue  Channel"
thumbnail.

Let's make it clear that choosing a color channel in the "Selections"
dialog doesn't deactivate the other channels (as it happens with the
Color and Tone dialog).



Loading Path, Mask, or Layer Opacity

This set of commands lets you instantly make a selection based
on the existing elements of your document.

The "Load Current Path" command uses the active path:

1. Create a new path or select an existing one.

2. Open the the  "Selections"  dialog and  apply the "Load
Current Path" command (fig. 1).

3. In the  "Make  Selection"  dialog,  define  feather radius
and operation  mode.  For  example,  you  can  soften  the
edges of a new selection and add it to an existing selection.
On the  screenshot  2,  the  author  adds  the  loaded  path
(apple) to the existing selection (girl).

The 3  following  commands  load as  selection mask of  the current
layer (of course, if such a mask exists). 

1.  To load the (pixel) layer mask, double-click the
"Load Layer Mask" command.

2. To load the  vector  mask,  apply  the  "Load Vector
Mask" command.

3. The "Load  Smart  Filter Mask"  command  loads
the filter mask .

At last,  the  "Load  Layer  Opacity"  function  makes
selections based on the current layer's borders.

NB Surely, not all of the described commands may be labeled as
"undocumented" (layer opacity and mask edges can be loaded
by the regular PSE means). Nevertheless, the author decided
that the included standard commands can save the user from
closing the "Selections" window too often.



Selection Loading Modes

Pay your  attention  to the "Load  as" radio -buttons under the
Channels list.  They  let  us  decide  how  to  handle  the existing
selection on loading the new one.

By default  the script suggests the  "New Selection" option,
which means  replacing  the  existing  selection.  However,  by
using the radio-buttons you can  add,  subtract,  or  
intersect the loaded selection with the previous one.

The selected mode apply to the following commands:

1.  Load Selected Channel.

2.  Load Layer Mask.

3.  Load Vector Mask.

4.  Load Smart Filter Mask.

5.  Load Layer Opacity.

In the  example  shown on the  screenshot,  the  Green  channel is
subtracted from the existing rectangular selection.



Managing Alpha-channels

As mensioned  previously,  the  alpha -channels are
selections saved in your document. In PSE, we can save,
load, and delete selections using the "Selection" menu.

E+ adds some alternative tools from the full Photoshop store.

First off, an  existing selection (e.g.,  just loaded channel)
can be  instantly saved  by  double-clicking the "Save as
Alpha-channel". A new item  immediately appears

in the Channels list.

For the  new  channels  PSE  automatically  generates
names like "Alpha  1",  "Alpha  2",  etc.  If  you prefer more
descriptive names  use  the  "Rename  Alpha -channel"

command.

To load  a  saved  selection,  choose  the  proper alpha-
channel in  the  Channels  list, define  (if  necessary)  the
loading mode  and  apply the "Load  Selected Channel"

command. Or just double-click the alpha-channel's  line in

the Channels list.

At last, if don't need a savaed selection any more, you
can get  rid of  it  by using  the  "Delete Alpha-channel"
command.



Duplicate Channel

The "Duplicate  Channel"  command  copies  the  selected
channel as a new alpha-channel.

You may use  it,  for  example, to  copy a saved selection to another
image as follows:

1. Open in Photoshop Elements two images having the same pixel
dimensions.

2. Select the document containing the saved selection.

3. Open  the  "Selection"  dialog  and  choose  the  proper  alpha-
channel in the left panel.

4. Apply the  "Duplicate Channel" command (fig. 1).

5. In the dialog that opens, select the target document (fig. 2) and
click "OK".

Another purpose of this command is creating an alpha-channel
from a color channel.

1. In the  left  panel of  the  "Selections"  dialog, choose  the Red,
Green, or Blue channel.

2. Apply the  "Duplicate Channel" command.

Share Selection

"Share Selection" command quickly copies the existing
selection to  another  image  without  saving  and then
duplicating an alpha-channel.

1. Open two images having the same pixel dimensions.

2. Create a selection in one of the images.

3. In the E+ "Selections" dialog, apply "Share Selection" 
command (fig. 1).

In case of more than two images of the same size, the script
opens an extra dialog letting you select the target document
(fig. 2).



Quick Mask Mode

Quick (temporary) masks let you edit selection with any painting tools.

1.  Open the the "Selections" dialog and apply the "Quick Mask Mode" command. In case a part of
the image has been selected  at  the  moment, now  it  is  covered with red overlay*. In the  Channels
list of  the  "Selections" dialog  there appears  a  "Quick  Mask" item. The current  layer  in  the Layers

palette is grayed out, which means that in this mode, any tools and commands only affect the quick mask
and not the image itself.

2. Close the "Selections" dialog, activate the Brush tool and and paint with black color to select some
area. The selection is indicated as a red overlay. To deselect, you paint on the quick mask with white
color*.

*Masking and selecting colors may vary depending on your choice in the "Quick Mask Options" dialog
(see below).

3. To soften  the  selection edges, paint /  erase  with  soft  brushes,  reduce stroke opacity, or "feather" your
mask with the "Gaussian Blur" filter (screenshot).

4. To only edit a specific portion of the mask you may pre-define it, e.g., with the Polygonal Lasso tool.

5. By default, the red overlay indicates the selected areas. However, you may open the "Selections"
dialog, apply  the  "Quick  Mask  Options"  command,  and  choose  the  "Masked  Areas"  option.
Additionally, the "Options" dialog lets you change overlay color or density.

6. To use the created mask, you have to return to the normal editing mode. Open the "Selections"
dialog once again and apply the "Exit Quick Mask" command. The quick mask turns to selection
and you can edit the selected portion of the image.



Select Color Range

"Select Color Range" is a handy tool for selecting continuously colored
areas.

1. If your image contains similarly colored areas, you may need to pre-
define the selected area roughly, e.g., with the Rectangular Marquee.
While a  selection is active, the  "Color  Range" only works within the
selected area (fig. 2).

2. In the Actions panel, play "Select Color Range" action (fig. 1). The
"Color Range" dialog that opens contains a black and white preview
thumbnail of the currently  selected  color.  The  white areas  indicate
"selected" range; the black ones mean non-selected.

3. In the image window, click on the color you want to select.

4. In the dialog box, activate "Add to sample"  eyedropper and click
in several other places to add more tints to the selection (fig. 2). To
remove a color range from the selection use "Subtract from sample" 

 eyedropper.

5. Adjust the tool's sensitivity with the "Fuzziness" slider (fig. 3).

6. When ready, click "OK" to commit the selection.



Layers

You open  the  "Layers"  dialog  by  double -clicking its
thumbnail in the Effects palette.

Also, if  "Elements+" set  is  loaded  to  your Actions panel,
you can call "Layers" dialog by pressing [F3] key.

As usually, the Commands panel is on the right side of the dialog box.

On the  left  side,  there is  a  list  of  the  document's  layers.  By choosing  its
items, you select the corresponding layers in the Layers palette.

As you probably  know,  an attempt  to  open the "Layers"  dialog while
multiple layers are selected, results in the following message:

So, to apply a E+ command to several layers, we have to resort to the
following workaround:

1. Select in the Layers palette one and only one layer.

2. Open the "Layers" dialog.

3. Select the required item in the Layers list (holding [Ctrl] key).

4. Apply a command from the Commands list.

Important! When  working with  large files the  "Layers" dialog may open
very slow.  To  speed  up the  script  check the  "Turbo" gadget that cancels
loading the layer tree (fig. 2). 
To activate the turbo mode prior to opening the dialog, hold down the
[Shift] key while starting the "Layers" script.



Rasterize Layer

The "Rasterize Layer" command converts the current type,
shape or smart-object layer to an ordinary raster layer, so,
that you can  edit  it  with  the  ordinary tools - Brush, Clone,

Paint Bucket, etc.

Unlike the  standard  "Simplify  Layer"  command,  this  method
doesn't flatten layer styles.

For example,  you  can  rasterize  a  text  layer  and  then filter it,
retaining in the meantime  a  customizable  "Drop  Shadow" and
"Stroke" effects.

Hide / Show Layer Style

Styles are  rather  important  trend  of  the  non-destructive
editing, because  they  alter  layers  visually  without  affecting
their contents. Furthermore, at  any  time  the styles can be
turned off and on.

Alas, PSE only allow us to disable all the document's effects at
once (Layer > Layer Style > Hide All Effects).

If you  decide  to  hide  a  style  of  an individual layer,
open the  "Layers"  dialog and  apply the  "Hide  Layer
Style" effect.

To turn on a hidden style, use the "Show Layer Style"
command.

 



Layer from Style

As you know, layer styles are very handy - at any time you can
re-open style settings and update them.

In the meantime, you can't edit styles in the "regular" way.
For example, how about erasing an unnecessary fragment of a
shadow?

1.  In  the Layers palette,  select  a  layer  with  the "fx"
mark.

2. Open the  "Layers"  dialog  and  double -click
the "Layer from Style".

Now the layer style appears in the palette as a separate
layer named like "Effects for <source layer's name>".

Keep in mind though that the style settings are not editable
any more.  Also,  you can't  convert  the  "Effect Layer" back to a
layer style.



Auto-Align Layers

This command automatically aligns layers based on similar content. 
For example, let's combine the vertical and the horizontal versions of the same landscape (fig. 1).

1.  Drag  the  "vertical"  shot into the  "horizontal" document.  Now we have two  similar  layers one
over another (fig. 2).

2. Open the "Layers" dialog box and, in the left panel, select the both layers (fig. 3).

3.  Apply  "Auto-align Layers" command.



4. In the dialog window that opens, choose one of the alignment methods* (fig 4).
*The detailed info on the alignment options is available in the Photoshop Help file.

5. Now PSE transforms the layers as to  combine  them  the  best.  Furthermore, it expands the
canvas to reveal all the content (fig. 5).

On the figure  6,  you can see the final  image. (The  aligned layers were auto-blended and the
empty areas were filled with the Clone Stamp tool.)



Auto-Blend Layers

The "Auto-Blend"  command automatically combines layer contents.

As an example, let's combine the two ducks into single picture.

1. Drag the source images into the same document.

2. Place the combined layers one over another with an overlap (fig. 1).

3. In case one of the layers is "Background", convert it regular layer (Layer > New > Layer from Background).

4. Open the "Layers" dialog and, in the left panel, select the both layers (fig. 2).

5.  Apply the "Auto-blend Layers'  command.

6. In the dialog box that opens, specify the blending purpose - Panorama or Stack Images (fig. 3).

7. The rest of  the  job  will be made automatically  (fig.  4).  If  you are not happy with the result, try to amend the layer
masks with a soft brush.



About Smart Objects

"Smart object"  is  a  kind  of  "child"  file  encapsulated  in  its  "parent"
document.

There are two kinds of smart objects: "embedded" and "linked" ones. In
the Layers palette, you can recognize an embedded object by the special 

 symbol on its thumbnail (fig. 1). The linked objects get marked with
the "chain"  pictogram (fig. 2).

An embedded  object is included in the parent document as a whole.
Which means  that  you  can open the containing PSD-file on someone
else's computer and  modify  the  smart  object  contents. The embedded
objects can significantly increase the file size.

The contents of a linked  is  stored  in  an  external  file, which usually
allows to keep the parent file smaller. To modify a linked object we have
to edit the related file file. Should the external file be missing, the linked
object still  will exist in  the  document,  however  we won't  be able to  edit
its contents.

***
Why use  smart  objects ? Well,  the  first  reason  is,  that  they  can  be
transformed non-destructively.

And even more  important  reason is  smart  filters. Imagine, that  you can
apply several  filters  to  a  text and then  edit  its contents  without starting
all over again.

On the other hand, the main shortcoming of the smart objects is that
you can't  edit  it  with  regular  tools.  For  instance,  if  you try to paint over
a smart object with the  Brush, PSE suggests "simplifying" layer.

You can  find  all  the  E+  functions  for  creating  and  handling  smart
objects in the Commands panel of the "Layers" dialog (fig. 3).

To use  these  commands  without  opening  the  Layers  dialog,  load
"C:\Elements+\15.0\Actions\Smart Objects.atn"  set  into  the  Actions
panel (fig. 4).



Convert to Smart Object

 "Convert to  Embedded  Object" and  "Convert to  Linked

Object" commands  create  a  smart  object  from  the  currently
selected layers.

If you use  the  "Layers" dialog, select  one or  more layers in the left
panel and apply a converting command in the right panel (fig. 1).

If you  prefer  the  Actions  panel,  select  the  source  layers in the
Layers panel and play the corresponding action (fig. 2).

On the screenshots, a smart object being created from three text
and one raster layers.

Also, these  commands  let  you  convert  an  embedded   smart
object to a  linked one and vise versa.



Open as Embedded / Linked Object

These two commands open any image file as a smart
object. The  imported  smart  object  appears  in  the
Layers palette as the only layer.

This lets  you,  for  example,  filter  your  picture  non-
destructively.

For opening RAW photos we strongly recommend  "Open

as Linked Object" command.

In this case, at any time, you can re-open the image with 

Edit Smart Object command in the ACR window and adjust
the exposure, sharpening, or white balance settings.



New Smart Object via Copy

In a document, you may use multiple instances of a single smart object. To create a "clone", you use
either the "Duplicate Layer" or the "Layer via Copy" command. The cloned instances are linked to each
other, so that by editing the object's contents you affect all the instances.

If you need an independent copy  (not  linked to  its  origin)  apply the  "New  Object via  Copy" 

command.

For instance,  on the  screenshot 1,  the  "Source Object  copy"  has been created from the "Source Object"
by means of the "Layer via Copy" command, while the "New Object via Copy" is a new (independent)
smart object. As you can see, the two copies seem to be absolutely identical.

Nevertheless, if we alter the contents of the original "Source Object" (by using either the "Edit Smart
Object" or the "Replace Contents" function), the changes only affect the linked "Source Object copy"
(fig. 2).



Edit Smart Object

This command lets you edit the contents of a smart object created with the Convert to Smart Object, Place as Smart
Object, or Open as Smart Object commands*.

1. Select a smart object in the Layers list.

2. Apply the "Edit Smart Object" command (fig. 1). 
*Alternatively, you may call this command by double-clicking a smart object's name in the Layers list (left panel).

3. In case  the  smart  object contains a  RAW photo,  Adobe Camera RAW dialog opens. Modify the settings as needed and
click "Done" button.

4. Other smart objects open in a separate window as ordinary documents (on the screenshot 2 - "Layer 11.psd"). Edit the
image as needed. (On the screenshot 2, the author has created adjustment layer "Invert".) Then save the edited smart
object (File > Save).

The source smart object in the original document (in our example - "slope.psd") updates immediately.



Export Contents  

Suppose, you are editing a PSD file created in Photoshop and need to edit a smart object it contains. 
Since the "Edit Smart Object"  command can't do this, you will need a workaround.

1. Select an  embedded (!)  smart  object and apply the "Export Contents" 
 command.

2. In the "Save" dialog that opens, choose a destination folder, file name
(let it be "sample.psd") and click "Save".

So, you have saved the smart object's contents as a separate PSD file.

3. Now open the exported file "sample.psd"  (File  > Open),  edit  it as
needed and save the file (File > Save).

4. Choose the  initial  document,  the  "sample.psd"  has  been  exported
from.

5.  Open the "Layers" dialog, make sure that the smart object is selected,
and apply the "Replace Contents"  command.

6. In the  "Place"  dialog  that appears, browse  to the "sample.psd" file
and click "Place".

Thus we have replaced the original smart object with a modified copy.

Replace Contents
 

This command lets you replace the contents of a smart object with any image file 
on your computer.

1. Make sure, the wanted smart object is selected.

2. Apply the "Replace Contents"  command.

3. In the "Place" dialog box that opens, choose a source file and click "Place".
It may be a layered PSD, JPEG, RAW, or even PDF file.

4. If necessary, adjust size and position of the the imported object.

 



Split Smart Object

This command divides a smart object into the source
layers.

1. Make sure the needed smart object is selected.

2. Apply the "Split Smart Object"  command.

NB In case the object was created in full Photoshop, after
splitting you may want to adjust the source layers' position.

Handling Linked Files

In some cases a  linked smart  object may not  update after editing
its corresponding  file.  In  the  Layers  panel,  such  objects are
marked with the "warning"  pictogram.

To force  renewing  a  smart  object  run  "Update Modified

Content" command.

 "Reveal in Explorer" command helps you find the linked file

on your computer.

To link  a smart object  to  a different file - - for  example,  after
moving the  original  one -- apply   "Relink to File" command

and browse to the required image on your computer.



Styles

The layer styles let us create dazzling visual effects without editing the layer content. A single style 
may include various effects and blending options.

Alas, not all effects and settings of full Photoshop are available in PSE. 
Now you can find the missing options in E+ "Styles" dialog.

1. Select a suitable layer in the Layers panel.

2. Open  E+ Styles  dialog,  select an effect  in  the list to
your left (fig.  1),  check "Enabled" gadget (fig.  2),  and
define the effect settings (fig. 3).

*The effects applied to the current layer are marked in
the list with the "eye"  symbol (fig. 1).

3. To turn off an applied effect, select it in the list and
uncheck the "Enabled" checkbox.

4. While the script dialog is open, Photoshop Elements
may not  display  the  editing  progress  in  the  image
window. The preview at the dialog top (fig. 4) lets you
evaluate the result in real time.

5. If the edited layer is taking up only a fraction of the
document, the preview may be too  small.  To  make it
usable, prior to  opening the  Styles dialog, select the area
of interest with the Rectangular Marquee  Tool (fig. 5).

6. In case you need to display the  current result in the
image window, click the gray square (fig. 6), that opens
Color Picker  dialog.  This  trick  updates  the  image
window. To dismiss the Color Picker, press [Esc] key.

7. To apply the created style, click "OK" button (fig. 7).

8. To save the style as a preset for later use, click "Save" button (fig. 8).

NB. For more detail on each effect and its settings, read the full Photoshop documentation.



Fill Opacity

"Blending Options"  tab  contains  undocumented  settings  that also
can change a style's appearance.

First off, consider "fill opacity" -- an alternative method for reducing
layer visibility.  Unlike  ordinary  "opacity",  "fill"  doesn't  fade layer
styles. For  example,  you  can  hide  an  object  and  retain its "Drop
Shadow" effect.

To control fill opacity in PSE, use "Fill Opacity" slider.

On the screenshot, the fill opacity of the text layer "Even" is reduced
to 0%; the fill of the "More" layer is 25%; the fill of the "Elements"
layer is  75%. In the  meantime,  the  "Stroke"  and "Shadow"  effects of
all the three layers stay equally opaque.

To restore the normal behavior, just delete the layer style 
(Layer > Layer Style > Clear Layer Style).

Unblending Color Channels

Sometimes, we can you make cute visual effects by merely excluding
channels of the current layer from blending with underneath layers.

You achieve this by unchecking "R" (Red), "G" (Green), or "B" (Blue)
gadgets in the "Channels" line:

The screenshot  exemplifies  unblending  the  Green  channel  of  the
"Layer 1".



Knockout

"Knockout" is a special blending mode, turning a layer to a
kind of  a  "mask"  for  all  underlying  layers  except  for the
Background layer .

To create this effect:

1. In the  Layers  panel,  select a layer that should serve as a
mask. (On the screenshot, it's the text layer "LIFE".)

2. Now,  in  the  "Knockout"  menu,  you  have  to  choose  a
knockout type (fig. 2) -- either "Shallow", or "Deep".
- The "Deep" knockout "punches through" all the layers except
for the "Background". Visually, the "mask" gets filled with the
"Background" layer's contents (fig. 1).
- If  you  want  to  stop  the  effect  before  (over)  the
"Background", choose in the "Knockout" menu the "Shallow"
item, and then  group the  "masking"  and the "masked" layers.
In this  case, the "mask" gets  filled  with the contents of the
next layer after (under) the group.
- If  you  want  to  punch  through  the  "Background" (to
transparency), convert  it  to  regular  layer  (Layer  >  New >
Layer from  Background)  or just  hide it by  unchecking  the
"Visible" gadget.

3. Once  you  have chosen  the knockout method,  reduce  the
layer's fill opacity to zero. If you decide to show the "punched"
layer contents, slightly increase this value (fig. 3).

4. To  turn  off  the  effect,  select  "None"  in  the "Knockout"
menu or increase the fill opacity to 100%.



Blend If

The bottom  section  of  the  "Blending  Options"  tab  allow  excluding
specific tonal ranges of overlapping layers from blending.

1. For example,  to  replace the  light  sky on the  current layer with the
darker sky on the underlying layer (fig. 1):
- In "Blend If"menu, select "Gray" channel (fig. 1/1).
- Choose "This Layer" tab (fig. 1/2).
- Pull  the  "white"  slider  to  the  left  (fig. 1/3), until the underlying sky
shows up.

2. Another approach to the sky replacement: blending blue color of the
current layer in case this color is missing in the underlying layer (fig. 2):
- In "Blend If"menu, select "Blue" channel (fig. 2/1).
- Choose "Underlying Layer" tab (fig. 2/2).
- Pull the  "black"  slider  to  the  right (fig.  2/3), until the underlying layer
shows through.

3. If  the color  transitions look  harsh,  check  "Split"  gadget (fig. 2/4).
Now you have two separate sliders (2/3 and 2/5) for defining a range of
partially blended pixels.



Saving Custom Styles

Suppose, while editing an image, you created a cool new
layer style. And now you want to save it for later use.

So, to save a custom style:

1. In  the  Layers  panel,  select  a  layer  containing  the
created style (fig. 1).

2. Open  the  "Styles"  dialog  and click  "Save"  button (fig.
2).

3. In the  dialog  that  opens,  enter  the  name for  the  new
style and choose destination category. To create a new
set, select  in  the  drop  menu "New  category..."  item  and
enter the set name (fig. 3).

To use a saved custom style:

4. Restart PSE Editor.

5. Activate the  Custom Shape   (fig. 5) or any other
vector shape tool.

6. In the Options panel, open the "Style Picker" palette
(fig. 6/1) and select your custom category (fig. 6/2).

7. Drag your style from the "Style Picker" palette (fig.
7/1) and drop it onto a target layer -- either in the image
window (fig. 7/2) or in the Layers panel (fig. 7/3) .



Masks

 

Just in case you didn't know, a mask allows us to hide a certain
area of the layer it belongs to.

Officially, Photoshop Elements only supports pixel masks, often
referred to as "layer masks". In the meantime, a single layer may
contain up to three masks - a pixel mask, a vector mask, and a
filter mask (applies only to smart-filtered smart objects).

To access the additional masking features, you open
the "Masks" dialog by clicking its thumbnail in the
Effects panel.

The Commands list is sorted out according to
nature of the mask and kind of the task. For

example, on the screenshot you can see 3 command sets - for
creating a new (pixel) layer mask, for handling the existing
vector mask, and for adding a vector mask to the backward
(below) layer.

The sliders in the left part of the dialog let you adjust a mask's
density and soften its edges non-destructively.



Refine Mask Edge

This command  allows  you  to  fine -tune layer  mask
edges by means of the "Refine Edge" dialog.

1. Open the "Masks" dialog box.

2.  Apply the "Refine Edge"  command.

3. In the "Refine Edge" dialog, Choose preview mode that

better emphasizes your mask edge - with  or without 

 overlay.

4. Remove the  jagged  edges  with  the  "Smooth"  slider. Be
cautious though - smoothing may deselect some important
detail.

5. If necessary, soften  the mask  edges with the  "Feather"
slider.

6. Use the "Contract/Expand" slider to adjust the size of the
masked area.

 



Duplicate Layer Mask

Sometimes you  may  want to copy a  created  mask from one
layer to  another.  Since you can't  [Alt]-drag the  masks  in  PSE,
you need a special command.

1. In the Layers panel, select the layer containing the pixel mask you
want to copy.

2. Open the Masks dialog.

3.  Apply the  "Duplicate Layer Mask" command.

4. In the dialog that appears, choose the target layer (fig. 1) and click
"OK". If you want to copy the mask  to all the layers check the "All
Layers" checkbox.

In the  screenshot 2, you can  see  the  result of copying the mask from
the "Layer 1" onto the "Layer 2".

Show Mask Overlay

Sometimes, while editing a layer mask, we can't say for sure
which areas are already masked and which are not.

To see  the  mask channel  right in  your  image window, open
the "Masks"  dialog  and  apply  the  "Show  Overlay" 

command.

In this mode, the mask is displayed as a 50% red overlay.
This lets you scrutinize the mask and edit it more precisely.

To hide  the  mask and see  the  composite image as  it  is, use
the "Hide Overlay" command.

Tip. Showing the mask channel may be even more helpful
while editing smart filter masks.

 

 



Creating Vector Mask from Shape Layer

"Vector masks" hide certain area of layers they belongs to. Due to
vector nature such masks  have sharp clear edges  and can  be resized
without loss of quality.

PSE naturally  supports  this  kind  of  masks  for  shape  layers.
Elements+ extends this feature to all the other layer types.

Since Photoshop Elements lacks the Pen and other advanced vector
tools, you can only create a vector mask from a shape or path.

How to make a vector mask from a shape:

1.  Use the  Custom Shape,  Oval, or  any other vector  drawing  tool  to
create a  shape  layer  in  front  of  any  "maskable"  layer *. On the
screenshot 1, the "Shape 1" is ready for masking the "Layer 1".

*You can't mask the Background layer. Also, make sure the target
layer hasn't an existing vector mask yet. If it has a raster
(ordinary) mask, the two masks may co-exist.

2. Open the  "Masks"  dialog  and  apply  the  "Vector  Mask  for
Backward Layer  From  This  Shape"   command.  On  the

screenshot 2, you can see the result of the "backward masking".

3. If necessary, adjust  the mask  size and  position, or  invert  it as
explained here.

NB Alas, Photoshop Elements doesn't let us to draw on an existing
vector mask. To create a mask from several shapes, you draw those
on the same shape layer (using the "Add to shape area +" mode)
and then convert it to a vector mask for backward layer.



Vector Mask from a Path

You can create a vector mask from a path as follows:

1.  Open the "Paths" dialog.

2. Select an  existing  path or  create a  new  one. For example, the
path shown on the screenshot has been made from selection.

So, the  source  path  must  be  active, which  means  its outlines
should be visible in the document window.

3. in the Layers palette, choose a maskable layer.

4. Open the "Masks" dialog.

5. Apply the  "Create  Vector  Mask  From  Current  Path"  

command.

6. If necessary, invert the mask, adjust its size, or invert it.

NB Photoshop Elements doesn't allow you to draw on an existing
vector mask. To create a mask from several components, you
create a complex path from several shapes or selections and then
convert it to a mask.

Duplicate Vector Mask

This command lets you copy a vector mask from one layer to
another as follows:

1. In the  Layers  panel,  select  the  layer  containing  the vector mask
you want to copy.

2. Open the "Masks" dialog.

3.  Apply the  "Duplicate Vector Mask" command.

4. In the  dialog  that  appears,  choose  the  target layer and click "OK".
If you want  to  copy the  mask to  all the  layers check the  "All Layers"
checkbox (fig. 1).

In the screenshot 2, you can see the result of copying the vector mask
from the "Shape 1" layer onto the layers "Layer 1" and "Layer 2".



Disable Vector Mask

If you don't  need a vector  mask any more,  you can  delete  it by
dragging its thumbnail in the Layers palette onto the "trash" 
button, or with the help of the E+ "Delete Vector Mask" 

command.

In the  meantime,  if  you may need the  mask later on, you don't
need to remove it completely.

The "Disable Vector Mask"  command lets you turn off a

vector mask temporarily, rather than delete it.

To turn  on  the  disabled  mask,  you  use  the  "Enable Vector
Mask"  command.

Tip. Alternatively, you can disable / enable a vector mask by
[Shift]-clicking its thumbnail in the Layers palette.

Deselect Vector Mask

Although PSE doesn't allow us to edit vector masks, the current
layer's vector  mask  is  always  active  (i.e.,  ready  for editing).
That's why  the  mask's path  is  always  visible  in  the image
window, and you can't  hide  it  even by using [Ctrl+H] shortcut.
This also  means  that  you  can't  hide  outlines  of the current
shape layer (fig. 1).

The "Deselect  Vector  Mask"  command  lets  you  preview
the image without unnecessary extras (fig. 2).

Later on, you will be able to re-
activate it by clicking the mask
thumbnail in the Layers palette.



Rasterize Vector Mask

 

This command  converts  a  current  vector  mask  to  an
ordinary (pixel) one.

This enables the use of raster tools and commands. For example,
you can blur the  rasterized mask, paint on it with the Brush tool,
etc.

In case  the  layer  has  contained  a  pixel  mask  as  well, after
rasterizing the both masks merge into a single pixel mask.

Filter Masks

"Filter masks" is  yet  another great  feature of  smart  filter allowing us  to  hide  an  effect  without  masking the  layer  itself.  Actually,  once a smart  
filter is created it already has a "white" layer mask. However, since a filter mask thumbnail doesn't appear in the Layers palette, you can't activate 
it directly as Photoshop users do (fig. 1).

In PSE you mask smart filters as follows:

1. Select a "filtered"  smart object in the Layers palette.

2. Open the "Masks" dialog box.

3. If you want just to activate the filter mask without altering it, apply the "Select Filter Mask"  command.

There appear white "dashes" around the  smart  object's  thumbnail,  meaning  that  the  filter mask is  currently active  and you can edit it 
directly. For example, paint on the image with black color to hide filter effect in certain areas. On the screenshot 2, the author masks smart 
filters on the girl's face and knees.  Let's  make  it  clear that  if  an  object has 2  or  more  smart  filters  applied to  it,  the mask hides them all. 
Masking individual filters is impossible.



Additionally, the "Masks" dialog suggests several functions for instant creation or editing filter masks:

4. The "Reveal Filter"  command fills the mask with white color, thus revealing the whole layer to the filter effect.

5. The "Hide Filter" command hides the filter effect completely by filling the mask with black color.

Sometimes, it is more convenient to create a mask from an active selection.

6. The "Filter Selected"  command reveals the selected area and hides the rest of the layer from the filter effect.

7. And vise versa, the "Unfilter Selected"  commands only shows the filter effect on non-selected fragments of the smart object (fig. 3).

8. To exit the mask editing mode (for example, you may want to adjust the settings of the filter itself), de-activate the filter mask by 
clicking the smart object's thumbnail in the Layers palette or apply the "Deselect Filter Mask"  command. The white "dashes" disappear.



Show Filter Mask Overlay

Since, in  PSE, filter mask  thumbnails  don't  appear in  the  Layers  palette, we  may  not know which
exactly parts are already masked and which are not.

To see the filter mask channel right in your image window, open the "Masks" dialog and apply the
"Show FM Overlay"  command.

In this mode, the mask channel is displayed as a 50% red overlay. This lets you scrutinize the mask and
edit it more precisely.

To hide the mask channel and see the image as it is, use the "Hide FM Overlay"  command.

Disabling Smart Filter Mask

 

The "Disable Filter Mask" command lets you turn off
a smart  filter  mask  temporarily,  as  we  do  it with
ordinary masks.

On the screenshot, the smart filter affects the entire layer,
because its mask is  turned off. The red  overlay is turned on
to show the mask shape.

To turn  on  the  disabled  mask,  you  use  the "Enable Filter
Mask"  command.



Adjusting Mask Density

"Density" sliders in the left part of the dialog window
let you adjust the mask opacity. In othe words, they
make the black areas of the mask translucent.

Since this operation is non-destructive, later on you
will be able to restore the mask opacity without any
loss of quality.

1. So, select a masked layer in the Layers pane.

2. Open the "Masks" dialog.

3. To reduce opacity of the pixel mask, move
the "Density" slider in the "Pixel Mask" panel
(screenshot).

4. To set opacity of the vector mask, use the
"Density" slider in the "Vector Mask" area.

5. To adjust density of the smart filter's mask
use the respective slider in the "Filter Mask"
panel.

6. If you need to restore the mask opacity, open
the "Masks" dialog once again and set the
"Density" value to 100%.



Feather Mask Edges

"Feather" sliders in the left part of the dialog window
let you soften the mask edges.

Since this adjustment is utterly non-destructive, later
on you will be able to restore the mask sharpness
without any loss of quality.

1. So, select a masked layer in the Layers pane.

2. Open the "Masks" dialog.

3. To blur edges of the pixel mask, move the
"Feather" slider in the "Pixel Mask" panel.

4. To soften the vector mask's edges, use the
"Feather" slider in the "Vector Mask" area
(screenshot).

5. To feather the smart filter's mask, use the
respective slider in the "Filter Mask" panel.

6. If you need to restore the mask sharpness,
open the "Masks" dialog once again and reset
the "Feather" value to 100%.



Smart Filters

Unlike ordinary filters, "smart"  ones let  you process  your images
non-destructively. That is, later  on you  may  change your mind
and alter  the  filter  settings,  or  utterly  "unsharpen",  "unblur",
"undistort" it, etc..

To access  the  smart  filter  related  functions,  you
double-click the  "Smart  Filters"  thumbnail  in the
Effects palette.

On the left  side  of  the  "Smart Filters" dialog box,
you can  see  a  list  of  smart  filters  that  has  been

applied to the current smart object previously.

Under the  Filter  list,  there is  a  drop  menu,  allowing you to add a
new filter.

Another drop menu  appears  if  the script  finds supported third
party plug-ins.

On the  right  side  of  the  dialog,  you  can  find  the  traditional
Commands panel.



Adding a Smart Filter

As you, probably, know, a smart filter can only be applied to a
smart object.  To smart-filter an ordinary  layer,  you have to
convert it to smart object. If the current is not a smart object,
the script creates a smart object for the composite image.

Although, in  full  Photoshop,  a  smart -filter is  created
automatically, whenever you apply any filter to a smart object,
in PSE you need some help of Elements+:

1. Open the "Smart Filters" dialog.

2. Choose a filter in the "New filter" menu (fig. 1).

3. In case a dialog box opens, adjust settings for the selected
filter and click "OK" button (fig. 2).

In the left panel of the "Smart Filters" dialog, there appears
the first  item.  In  the  Layers  palette,  you  can  notice  the
"smart-filter"  icon on the smart object's line.

4. To add to  smart  object yet  another filter,  just  use  the drop
menu once again.



Editing Smart Filter Settings

As we already mentioned, smart filter settings can be re-edited at any time.
1. In the Layers palette, select the appropriate smart object.

2. Open the "Smart Filters" dialog.

3. Select the wanted filter in the Filters list (fig. 1) and apply the "Edit Filter"  command. Or simply

double-click the filter line in the list.

4. This re-opens the filter dialog box, so you can alter its settings as needed. When ready, click "OK" to
confirm the changes (fig. 2).



Disabling Smart Filters

Although Photoshop Elements  doesn't  support smart  filters  officially, it  offers some basic functions for
handling them. In the Layers palette, right-click the  icon in a smart filter's line and choose the
"Disable Smart Filters"  command. Then  right-click this   icon  again  and  choose  "Enable Smart
Filters". To get rid of smart filters completely, choose "Clear Smart Filters" option.

But what if you have several smart filters on a layer? For example, you may want to hide the second of
3 added filters:

1. Open the "Smart Filters" dialog.

2. Select the proper item in the Filters list.

3. Apply the "Hide Filter" command, to disable the effect temporarily.

4. To turn on the disabled filter, you use the "Show Filter" command.

5. If you are  sure that  you don't  need the  selected  filter any more,  you may remove it  completely with
the "Delete Filter" command.

On the screenshot, you can see hiding the second of 3 smart filters applied to the current smart object.



Reordering Smart Filters

In case  a  smart  object has several  filters applied to it, altering
their stacking  order  may  dramatically  affect  the  composite
image view.

1. Open the "Smart Filter" dialog.

2. In the Filters list, select one of the added filters.

3. Apply the  "Move  Forward"   command  to  bring  the

selected filter upward (to the foreground).

4. Or apply  the  "Move  Backward"  command to send the

selected filter downward (to the background).

Smart Plugins

Along with the Adobe filters coming with Photoshop Elements, the third party plug-ins can also be applied as
smart filters.

In case  some of  the  plug -ins supported by the  "Smart  Filters" script  are  installed  in PSE,  they appear in a
separate menu (the supported plug-ins are listed below). You apply a plug-in by selecting it from the list, as
shown on the screenshot.

Then, you can handle the applied "smart-plugins" exactly like the standard filters -- edit, hide, change blending
mode, etc..

Please, keep in  mind,  though, that  the  smart  plugins  may behave differently from the standard smart-filters.
Their reliability and ease of use cannot be guaranteed.

Below is the list of the third party plug-ins supported by the
"Smart Filters" script:

- AKVIS Refocus
- AKVIS Enhancer

- Imagenomic Noiseware
- Imagenomic Portraiture
- Imagenomic Realgrain

- Nik Analog Efex Pro
- Nik Color Efex Pro
- Nik Dfine
- Nik Sharpener Pro
- Nik Silver Efex Pro
- Nik Viveza
 
- ON1 Perfect B&W
- ON1 Perfect Effects
- ON1 Perfect Enhance 

- Topaz photoFXlab
- Topaz Adjust
- Topaz BW Effects
- Topaz Clarity
- Topaz Clean
- Topaz DeJpeg
- Topaz DeNoise
- Topaz Detail
- Topaz InFocus
- Topaz Lens Effects
- Topaz ReStyle
- Topaz Simplify
- Topaz Star Effects



Paths

"Path" means non-printable vector outline, only visible while it's
active. However, you can easily convert this auxiliary substance
to a shape layer or use it to define printable area of the entire
image.

To access the corresponding functions, you open the
"Paths" dialog  by  double-clicking its thumbnail  in
the Effects palette.

The left panel of the dialog box displays paths that
already exist in the document.

The right  panel  contains  commands for  making  new paths and
handling the existing ones.

Creating Path from Selection

Let's consider making a path from selection:

1. Select some area using any selecting tools and commands.

2. Open the "Paths" dialog.

3. Apply the  "Create  New  Path  From  Current  Selection"  

command.

4. In the  dialog  box  that  opens,  define  "Tolerance"  (must  be
between 0,5 and  10 pixels).  For  example, to  make  the path as
close to  your  current  election  edges  as  possible,  type "0,5". To
make it smoother, enter "2,0" or an even higher value.

In the Paths list, there appears the fist item under the name of
"Work Path".

Attention! By creating a new Work Path you delete the previous
one. To avoid this you either save the path or convert it to a
vector mask.



Create Path from Shape

This command  saves  a shape outline  as a  path  and deletes the
source shape layer*.

1. Select in the Layers palette an existing shape layer or create a
new one.

2. Open the "Paths" dialog.

3. Apply the "Create New Path From Shape Layer"  command.

In the  left  panel there appears  a  new  item named  like "Path 1",
"Path 2" etc..

NB To create a path from vector mask of a raster layer, use the
"Create New Path From Vector Mask"  command.

Why convert a shape to a path? For example, to raster-stroke it
(see example).  Or to  incorporate a  vector  drawing  into a JPEG file
(unlike shape  layers,  paths  can  be  stored  with  various  image
formats).

*To create a shape-based path without deleting the source layer,
select this layer in the Layers palette, open the Paths dialog, and
apply the Saving Path  command.

Create Path from Text

This command makes a Work Path based on the current type layer.

1. Select in the Layers palette an existing text layer or create a new
one.

2. Open the "Paths" dialog.

3. Apply the "Create New Path From Text Layer"  command.

This function  doesn't  removes  the  source  type  layer.  So,  if
necessary, delete or hide it on your own.

Attention! By creating a new Work Path you delete the previous
one. To avoid this you either save the path or convert it to a
vector mask.

 



Selecting a Path

 

Once a created path is deactivated, you can neither use nor even
see it unless you select it again.

Since Photoshop Elements hasn't a Paths palette, you accomplish
this as follows:

1. Open the "Paths" dialog.

2. Click an item in the Paths list.

The screenshot  exemplifies  selecting  a  path  named  "Path  2"
(flower-shaped).

NB Selecting two or more paths simultaneously is not possible.

Saving a Path

As we  have  already  mentioned,  the  "Work  Path"  means
"temporary" path. For  example,  when you  create a  new path
from a  selection  or  from text, it  replaces  the  previous Work

Path*.

*Paths created from shape layers and vector masks are saved
automatically.

To secure the created Work Path:

1. Open the "Paths" dialog.

2. Make sure that the "Work Path" is selected in the Paths list.

3. Apply the "Save Path"  command.

4. In the dialog box that appears, enter desired path name and click
"OK".

Please note that you can't overwrite existing paths. For example, the
program won't  save a  path  as  "Path 1",  in  case  a  path  with  that name
already exists.

In conclusion,  let's  touch  saving  the  files  containing  paths. 
Unlike vector shapes,  paths may be saved to  various  file  types. For  example, you can incorporate your vector drawings 
into  a JPEG file and publish it on the Web.



Converting Path to Shape

The "Convert to Shape" command make a shape layer from the
current path.

This method,  lets  us,  for  example,  "vectorize"  a  raster  image  as
follows:

1. Select some object, e.g., with the Polygonal Lasso tool.

2. Open the "Paths" dialog.

3. Convert  the selection to path.

4. Apply the "Convert to Shape"  command (fig.1).

5. In the dialog box that opens, choose a fill color and click "OK".

As result, there appears a new vector shape layer (fig. 2).

Alternatively you may fill the active path with a gradient (Layer > New
Fill Layer > Gradient) or pattern (Layer > New Fill Layer > Pattern).

Fill Path

This function fills the interior of the current path with raster content:

1. Create a new path or select an existing one.

2. In the Layers palette, select an existing raster (!) layer or create a
new one.

3. Open the "Paths" dialog.

4. Apply the "Fill Path"  command.

5. In the  "Fill  Path"  dialog  that  opens,  choose  fill  type  -  color or
pattern - and other options.



Stroke Path

This function outlines the current path with a raster stroke:

1. Create a new path or select an existing one.

2. Create a new raster (sic!) layer or select an existing one in
the Layers palette.

3. In the Toolbox, activate a painting tool, you wish to stroke
with - Brush, Pencil, Clone Stamp, or some other painting tool.

4. In the  Options  bar,  choose brush  tip shape, stroke opacity
and other brush settings.

5. Define the foreground color.

6. Open the "Paths"  dialog and apply  the "Stroke Path" 

command.

7. In the  dialog  box that  opens,  choose  your  painting  tool  (the
same as chosen in step 3).

8. Optionally, you may activate  the  "Simulate  Pressure"  option
that dynamically changes the stroke width.

9. Click "OK" to stroke the path.  



Deselect Path

While the  current  path  is  active, you  can  see  its  outline  in the
document window. In Photoshop Elements,  you can't  hide  it  by using
[Ctrl+H] shortcut (fig. 1).

Furthermore, in some cases PSE doesn't allow you to use the Shape
tools (fig. 2).

To fix the problem, you have to deactivate the path as follows:

1. Open the "Paths" dialog.

2. Apply the "Deselect Path"  command.

On the screenshot 1, the author deselects path of the current shape
layer's vector mask.

If the  path  has been saved, later  on,  you will be able to  re-select it  in
the Paths list.

 

Handling Paths

Let's see what the other path-managing commands do:

1. Select a path in the left panel of the "Paths" dialog.

2. If you don't like the selected path's name, apply the "Rename
Path"  path command and type new name in the dialog box

that opens.

3. The "Duplicate  Path"   command  creates  a  copy  of  the

current path.  You may need it  for  example  to place identical paths
in different areas of your document.

4. At last, if you are sure, that you don't need the selected path any
more, apply the "Delete Path"  command.

 



To access the texting functions you use either
"Text" thumbnail in the Effects palette or
"Text" action from Elements+ action set.

As you can see, alongside with the common
Commands panel (fig. 1), the "Text" dialog

includes a number of sliders and drop menus.

While "Layer" tab is open (fig. 2), all those tools apply to the
entire type layer.

To modify just a selected portion of the text, go to
"Fragment" tab* (fig. 3).

*The "Fragment" tab is only available in PSE 11+ for
Windows. Editing selected fragments under Mac OS is not
currently possible.

Please, keep in mind that you can't use the Effects palette
while editing text content. This means, in particular, that
before opening the "Text" dialog, you have to exit "text
editing" mode by pressing [Ctrl+Enter] keys.

While the script dialog is open, Photoshop Elements may
not display the editing progress in the image window. The
preview at the dialog top (fig. 4) lets you evaluate the result
in real time.

If the edited text is taking up only a fraction of the
document area, the preview may be too small. To make it
usable, prior to opening the Text dialog, select the area of
interest with the Rectangular Marquee       Tool (fig. 5).

Text 



 

Letter Scaling

Scaling lets  you  alter  width  and  height of  characters without
transforming the entire layer.

1.  In the Layers palette, select a text layer.

2. Open the "Text" dialog.

3. Scale symbols  with "Width"  and  "Height" sliders  or  enter
percentage values (from "0" to "1000") in the proper fields.

4. To return to initial scale, set width and height to 100% or
apply the "Reset to Default"  command.

NB Scaling of substantial text pieces may take some time.
Please be patient.

 



Tracking

The tracking adjustment means widening or narrowing of spaces
between letters.

1.  In the Layers palette, select a text layer.

2. Open the "Text" dialog.

3. Define the  spaces  width  the  "Tracking"  slider or type  a value
from "-1000" to "10000" in the proper field.

4. To re-establish the default spacing, set the "Tracking" value to
100% or apply the "Reset to Default"  command.

NB Altering this parameter for substantial text pieces may take
some time. Please be patient.

Capitals

The "Capitals"  menu  lets  you represent the small  letters  of  the
current text as capitals.

1. Select a text layer.

2. Open the "Text"  dialog  and chose an  option in  the "Capitals"
menu (fig. 4).

3. For example, to represent all the letters as capitals (fig. 1), select
"All Caps"  mode.

4. To display  the  small letters  as  small capitals  (fig.  2),  choose
"Small Caps"  option.

5. To restore  the  default text view  (fig. 3), select "Normal" 
option.



Anti-aliasing

To smooth jagged text edges, Photoshop offers us four anti-
aliasing methods, while Photoshop Elements suggests just
one of those.

If you are not happy with the achieved result, try additional
options from the "Anti-aliasing" menu:

Sharp
Crisp
Strong
Smooth

Or select "None" to disable anti-aliasing.

Swapping Input Modes

As we  know, there are two texting modes in PSE - "single-line" and
"paragraph".

We add a  single -line (in Photoshop  terms, "point") text by clicking
with the Type tool. Each line of such a fragment is independent. To
start a  new  line  we  have  to  press  the  the  [Enter]  key  (upper
screenshot).

To add a "paragraph", we define its boundaries by dragging with the
Type tool. Paragraph text wraps automatically (lower screenshot).

Each method  has  its  own  pros  and  cons.  E+  allows  you to switch
between the two modes on the fly.

1. Select a text layer.

2. Open the "Text" dialog.

3. To turn  existing  "paragraph"  to  "point"  (single -line) text,
apply the "Convert to Point Text" command.

4. And vice  versa, "Convert to  Paragraph Text" turns point text
to paragraph. 



Paragraph Justification

Photoshop Elements  suggests  3  methods  of  paragraph  text
alignment - "Left Align", "Center", and "Right Align".

E+ adds  to  those  so  called  "justification",  which  means aligning
text lines to the both edges.

1. Create in your document a text paragraph 
(as opposed to "single-line" text).

2. Open the "Text" dialog.

3. In the "Align" menu, choose one of the justification methods
(fig. 5).

Actually, the four options only differ in the last line behavior:

1.  "Left Justified"  aligns the last line to the left edge of the
paragraph (fig. 1).

2. "Center Justified"  puts the last line to the paragraph center
(fig. 2).

3. "Right Justified"  aligns the last line to the right edge 
(fig. 3).

4. "Fully Justified"  aligns the last line to the both edges of the
paragraph (fig. 4).



Find and Replace

 

This command  calls  the  "Find  And  Replace  Text"
dialog. You  may  need  it  while  working with
voluminous text fragments.

Converting Text to Shape

This command converts the current type layer to a
shape layer.

1. Select a text layer.

2. Open the "Text" dialog.

3. Apply the "Convert Text to Shape"  command.

This method lets you, for example, select any letter with the
Shape Selection tool and then transform it individually.

In the meantime, you retain the vector nature of the object,
which means, in particular, lossless transformations.

On the other hand, you can't edit the inscription as text any
more.

 



Text on Path

Since PSE doesn't have the Pen tool, you can't draw a complex path for
your text with Bézier curves. To solve this problem at least partially,
E+ includes several templates for the most common tasks.

1.  Open a document you wish add a guided text to.

2. Open the "Text" dialog.

3. Choose a suitable template in the "Text on Path" menu.

Once you have selected a template, the script opens a file with ready
made guided text layers and duplicates those to the target document.

4. Now the script suggests adjusting the new layer size and position.

5. Then, replace the "Edit this text" phrase with your own text.

6. At last, in the Options bar, choose the font family, size, and color.

Text in Shape

Since PSE  can't  make  "shaped"  text  paragraphs,  E+  kit  includes
several ready made templates.
1.  Open a document you wish add a shaped text to.

2. Open the "Text" dialog.

3. Choose a suitable option in the "Text in Shape" menu.

The script  opens a file with shaped  paragraphs and  copies the text
layer matching your choice to the target document.

4. Adjust size  and position  of  the  imported  layer.  Distortion of the
initial proportions  is  not  advisable.  (Later  on,  you  will  be  able to
adjust paragraph width and height with the Type tool).

5. Replace the "Edit this text" phrase with your own text.

6. in the Options bar, choose the font family, size, and color.

 



Editing Text Fragments

 

1. To modify just a portion of the current text layer,
open the "Fragment" tab (fig. 1).

2. Select one or more characters in the text field
(fig. 2).

3. Use the controls to your left (fig. 3).

4. To get to know settings of a certain fragment,
select it in the text field (fig. 2) and click "Read"
button (fig. 4).

Important! The "Fragment" tab is only available
in PSE 11+ for Windows. Editing selected
fragments under Mac OS is not currently possible.



Scripts

As we  already  know,  both Photoshop  and  Photoshop Elements
support the JavaScript language. The scripting lets us automate
tedious repetitive operations, create complicated effects, extract
metadata from files, etc..

The E+ kit  includes dozens of  ready  made scripts of
different complexity  and  functionality  degree.  To
access the E+ scripts catalog, just double-click the
"Scripts" thumbnail in the Effects palette.

Also, if "Elements+" set is added into your Actions
panel, you can open the "Scripts" dialog by pressing [Shift+F3]
keys.

First off,  the  dialog  lets  you  explore  the  scripts  catalog  by
selecting appropriate categories in the drop menu.

Surely, you are  encouraged  to extend the  catalog by including
additional scripts,  either  downloaded  from  the  Internet  or
composed with your own hand.

To execute a script, you select it in the list and click the "Run" 
 button. Or just double-click the script name in the list.

In the  History  panel, executing  a script is recorded as a single
history state. To enable undoing individual steps taken by each
script, call  the  Scripts  dialog  from  the  Actions  panel  (!)  and
uncheck the "Suspend History" option.

The follow up pages of this manual explain why and how to use
the default E+ scripts.

 



"Favorites" category

The "Favorites" category is intended for easier access to the most
used scripts.

To add  a  script  from  another  category  to  Favorites,  either  use  the
"Favorites"  button, or copy the script file to "C: > Elements+ > 15.0

> Scripts" folder with any file manager.

To remove a script from the Favorites category, select it in the list and
click the "Delete"  button.

"Batch Optimized" Category

The "Batch  Optimized"  category intended  for  scripts optimized  for  the  batch  processing. That is all of
those can be executed "silently" (without user participation).

Exceptions are scripts having "-batch edition" suffix in their names. Although those scripts don't open dialog
windows, you customize their setting by using the "standard" versions of the same scripts.

It is exactly "Batch Optimized" scripts, that appear in the drop menus of the "Batch" dialog.

To use  for  the  batch  processing  a script from the "Commands"  or "Photo  Effects"  category (also executing
without dialogs),  copy it  to  the  "Batch  Optimized" folder,  by using  "Add  to  Batch"   button in the "Scripts"

dialog.

"Commands" Category

The "Commands" category of the E+ catalog includes simple functions executed without opening dialogs.

These scripts  are intended  for batch  processing. They  also  can  be  used as  elementary units  for generating
compound scripts.

To use one of those scripts, go to the "Batch Optimized" category, and click "Add"  button. Or copy the script

file into "C: > Elements+ > 15.0 > Scripts > Batch Optimized" folder with the help of your file manager.

 



"Edges" category

The "Edges" category includes miscellaneous edge and corner effects.
Most scripts from this category are suitable for batch processing.

 

Bleed Print

The "Bleed  Print"  script  imitates  a  paper  print  
without  margins.

Burnt Edges

This script adds to the image a kind of "scorched" margins.

Please note that the script defines the edge shape at random. 
So, if you "burn" several images, the look of each one will vary.

 



Film Edges

 

 
This script converts the current document to a "film frame".

The perforation is always created "along the frame", that is, at the
long document sides.

Filmstrip All

The "Filmstrip All" script combines all the open documents to a single "filmstrip".

The width of the strip is defined by the smallest image size.

Handstitching

This script "sews" the image to canvas with rough stitches.

The length and position of each stitch slightly vary, so, every time
you run the script the result looks a bit different.

If necessary, you may adjust the stitch color by double-clicking the
"Stitches" layer's thumbnail.

To change  the  background  texture  double -click the  "Canvas"
thumbnail.

 



Page Curl

 

 
The "Page  Curl" script  imitates  a  rolling up

page corner.

Photo Corners

 

 
The "Photo  Corners"  script  imitates  paper

holders in a photo album.



Rough Bounds

 

The "Rough  Bounds"  scripts  makes  the  image edges
coarse and uneven.

The color of the added margins depends on the Background
color currently selected in your Toolbox.

Torn Edges

 

This script imitates a paper print with rudely 
ripped edges.

Please note  that  the  script  defines  the  edge shape at random.
So, if you "tear" several images, the look of each one will vary.

This means  also that  if  you don't like  the  result,  it  makes
sense to undo the "Torn Edges" [Ctrl+Z] and try once again.

 



Wavy Edges

 This script makes the image border wavy.

After applying  the  script,  you  can  alter  the  margin color
(white by default)  by double -clicking the  fill  (forward)  layer's
thumbnail.

Yellowed Margins

 
This script imitates a photo print with slightly yellowed

margins.

Zig-Zag

 

This script  makes  zigzag  notches  along the document
edges.

After applying the effect, you can alter the margin color (white
by default) by double-clicking the forward layer's thumbnail.



"Events" Category

The scripts  of  "Events"  category  are meant  to  be  automatically  launched with  the help of
"Script Events Manager". Thus, we can get rid of some routine tasks or alter PSE tools' behaviour.

       

        Duplicate Background
If you  always  begin  an  image  editing  with  duplicating  its

Background layer now you can automate this step and forget about
it.

1. Open  "Script  Events  Manager"  dialog  and make sure that "Enable
Events To Run Scripts" option is enabled (fig. 1).

2. Choose  "File"  category  (fig. 2/1) and  select  "Open Image" event
(fig. 2/2).

3. In  the  scripts  dropdown  menu,  choose  "Duplicate  Background"
item (fig. 3).

4. Click  "Add"  button  (fig.  4/1)  and  make  sure  the  new  "Event:
Script" line is available in the upper list (fig. 4/2).

From now  on,  whenever  you  open  a  flat  document  the script
duplicates its layer.

In case  the  opened  document already  has some additional  layers no
duplication occurs.

 



Make Paintable

If while working with the  Brush or other painting tools
you often  get  error  messages  (fig.  0),  consider  using  "Make
Paintable" script.

1. Open  "Script  Events  Manager"  dialog  and make sure that "Enable
Events To Run Scripts" option is enabled (fig. 1).

2. Choose "Tools" category (fig. 2/1) and select "Brush Tool" event
(fig. 2/2).

3. In the scripts dropdown menu, choose "Make Paintable" item 
(fig. 3).

4. Click  "Add"  button  (fig.  4/1)  and  make  sure  the  new  "Event:
Script" line is available in the upper list (fig. 4/2).

From now on, by selecting  the   Brush  tool you  automatically
prepare a surface for painting:

- In case the current layer is  locked, the script unlocks it.
- If the  current  (either  vector or  adjustment) layer has a a raster
mask, the script activates it for painting.
- In case neither layer nor mask is paintable, the script creates a new
raster layer.

Tip: you may bind this script to "Select Clone Stamp Tool" and
"Select Pencil Tool" events as well.



Open Last File

Many applications on startup automatically open the last file, so,

that you  can  continue  editing  it.  Now  you  can  add  this  feature  to
Photoshop Elements.

1. Open "Script Events  Manager" dialog  and  make  sure  that "Enable
Events To Run Scripts" option is enabled (fig. 1).

2. Choose  "Default"  category  (fig.  2/1)  and  select  "Start Application"
event (fig. 2/2).

3. In the scripts dropdown menu, choose "Open Last File" item (fig. 3).

4. Click "Add" button (fig. 4/1) and make sure the new "Event: Script"
line is available in the upper list (fig. 4/2).

Reopen RAW as Smart Object

Opening a  RAW  photo  as  a  linked  smart  object  lets  us -- if

necessary - - reopen  the  ACR  dialog  and  adjust  the  exposure,
sharpening, or white balance settings.

If you wish to open all your RAW files in this way, "Reopen RAW as
Smart Object" script may come in handy.

1. Open "Script Events  Manager" dialog  and  make  sure  that "Enable
Events To Run Scripts" option is enabled (fig. 1).

2. Choose "File" category (fig. 2/1) and select "Open Image" event (fig.
2/2).

3. In  the  scripts  dropdown  menu,  choose  "Reopen  RAW  as Smart
Object" item (fig. 3).

4. Click "Add" button (fig. 4/1) and make sure the new "Event: Script"
line is available in the upper list (fig. 4/2).

From now on,  if you  accidentally  open a RAW file  with  the  regular
"Open" command,  the  script  closes  the  photo and reopens it as a linked
smart object.

 



History Log

This script lets you write the image editing history to an external text file.

1. Open "Script Events Manager" dialog and make sure that "Enable Events To Run Scripts" option is enabled (fig. 1).

2. Choose "Miscellaneous" category (fig. 2/1) and select "Everything" event (fig. 2/2).

3. In the scripts dropdown menu, choose "History Log" item (fig. 3).

4. Click "Add" button (fig. 4/1) and make sure the new 
"Event: Script" line is available in the upper list (fig. 4/2).

From now on, all the editing history is recorded to a text file.

For each  edited  document the  script  creates  a  separate log-file
saved under the same name and in the same folder as the source 

image file. In case of a new document, the log-file is saved to 

the Desktop.

NB. Let's make it clear that the history logging doesn't let you undo 
the changes. The log file only contains a concise summary of the 
editing progress. Furthermore, painting and some other activities 
cannot be recorded at all.

NB 2. As we already mentioned, the above method 
presupposes launching the script after every step, which 
may affect PSE performance.

Show Swatches Panel

This script opens the Color Swatches panel on a certain event.

For example let the Swatches open on selecting the  Brush tool.

1. Open "Script  Events  Manager" dialog  and make  sure  that 
"Enable Events To Run Scripts" option is enabled (fig. 1).

2. Load "Tools"  category (fig.  2/1) and choose "Select Brush Tool" 
event (fig. 2/2).

3. In the scripts dropdown menu, choose "Show Swatches Panel" 
item (fig. 3).

4. Click "Add" button (fig. 4/1) and make sure the new 
"Event: Script" line is available in the upper list (fig. 4/2).

From now on, whenever you activate the  Brush, 
the Color Swatches are already at hand.

Tip: In a similar way, you can bind the Info panel to the  

Color Picker (Eyedropper) tool or the Layers panel to PSE startup. 



"Files" Category

The "Files" category is intended for the file managing, batch processing, and similar utilities.

 

      Action to Script

This utility  lets  you  play  actions  (Photoshop  macros)  with the
help of scripts.

Why might  we  need  it ? For  instance,  to  use  an  action  for  batch
processing.

Suppose, you've found an action set (.ATN file) on the Internet and want
to apply one of its effects to a large series of photographs.

1. Open the Actions  panel menu,  choose  "Load  Actions", and find on
your computer the downloaded .ATN file.

2. Run "Action to  Script"  script that opens a dialog shown on the
screenshot 2.

3. In "Set name" menu, choose the required action set (folder). In the
example shown on the screenshots, it's "X-Art".

4. In "Action name"  menu,  choose  a specific action in  the  loaded set. In
our example, it's "X-Poster".

5. In "Category" menu, choose a target folder of the Scripts catalog to
save the created script. To use the action for the batch processing, you
select "Batch Optimized" category (screenshot 2).

6. To create the launching script, click "Save" button.

Now for  batch -playing the  "X -Poster" action,  you  simply  select  the
corresponding item in the drop menu of the "Batch" dialog (fig. 3).

Important! The thus created scripts are mere action-launchers. If you
remove an original action from the Actions panel, the corresponding
script just won't work.

Note: This  script doesn't work with App  Store  version of  Photoshop
Elements.

 



Batch

The "Batch" script  is  designed  for  processing  multiple  images  automatically.  On the  launch,  the  script  opens  the
dialog box shown on the screenshot.

1. First of all, you define, in the drop menu of the "Source" area, which files should be edited -- all the currently opened
documents (Open Files) or a whole folder with images (Folder). The latter option opens a dialog for choosing the source
folder.

2. Then,  in  the  menus  of  the "Scripts  to  Run"  area, select one or
more scripts that you wish to execute.

If you need to disable a selected script, choose "Do Nothing" item
instead. To clear all the fields and set up a new script sequence, click
the "Reset Scripts" button.

Please note  that  the  menus  only  include  scripts  from  "Batch
Optimized" category of the E+ catalog.

If you wish to  batch-play a  script  from  a  different  category  (e.g.,
"Commands"), first  copy it  to  the  "Batch  Optimized" folder  by using
the "Add  to  Batch"   button in  the  "Scripts"  dialog. For  example,

on the  screenshot, you  can see two  additional  commands  - "Auto
Contrast" and "Saturation+20".

To batch-play an  action (Photoshop macro),  load it  into the  Actions
panel and  then  add  it  to  the  "Batch  Optimized"  category  of the
Scripts catalog with "Action to Script" tool.

3. In the "Destination" area, you decide what to do with the edited
images -- export  to  specified location  (Save to  Folder)  or not to save
and leave the documents opened (None). The "Save to Folder" option
lets you specify the output file format and other saving options.

4. At last, click "Run" button to launch the batch processing.

Please note,  that  when  you  click  "Run",  the  "Batch"  dialog
remembers all your  settings.  If  you need to  save the current settings
without processing images, just click the "Save and close"  button.



Close All, Close Other Docs

Sometimes, if you happen to close a whole bunch of documents,
the PSE queries, whether you  want  to  save them or  not,  may
seem rather annoying.

The script "Close All without Saving" lets you get rid of the
unnecessary documents with a single click.

The "Close  Other  Docs" script  closes  without  saving all the
opened documents except for the current one. (On the screenshot
below, it's the "DSC_2881.jpg" document.)

NB If you want to save all the closed files, use the "Save All"
script first.

Copy All to Folder

This script saves copies of all currently open documents to
a specified directory.

1. Click the  "Browse"  button and  define  the  path to the target
folder.

2. Choose a target format  - JPEG,  PSD,  or  TIFF.  For  JPEG files,
you can also set the compression rate.

3. The "Overwrite existing files" option stipulates what to do in
case the target folder already contains a file with that name - skip
or overwrite.

 



File Piler

The "File  Piler"  script  loads  image files  into a document as
layers.

1. In the "Source" drop menu specify which files should be loaded -
all the currently  opened  documents  (Open  Files),  not opened files
from your computer (Selected Files), or a whole folder with images
(Folder). The  two  latter  options  open  a  dialog  for  choosing  the
source folder or files.

2. In case  each  image (even a multi-layer PSD) must  be loaded as  a
single layer, check the "Merge if Layered" gadget.

3. In the "Destination" menu, choose the target document - either a
new empty document, or the current image (fig. 1).

4. Click "Run" to launch the script.

On the screenshot 2, you can see the result of importing.

 



Exporting Layers to Files

The "Layers  to  Files"  script  saves  layers  of  the  current
document as individual files.

1. Open a layered document. On the screenshot, the author has
opened an animated GIF file.

2. From the "Scripts" dialog, launch the "Layers to Files" script.

3. In the  dialog  box  that  appears,  click  "Browse"  button  and
choose a folder where the exported files will be saved to.

4. Define file format in the "Select Output Format" menu.

5. In the  "File  Naming"  area  specify  file  naming  rules. For
example, on the screenshot, the file names should be comprised
of the "fish_" prefix and the source layer name.

6. Click "Run" to launch the script.



New Image from Selection

 

The "New  Image  from  Selection"  script makes a new
document from the selected area of the current one.

 

Open All Recent

 

This script  opens  all  the  files  from  your  "Open Recently
Edited" list.

As is  generally  known,  the  number of  items in this list can be
customized in PSE Preferences (Edit > Preferences > Saving
Files).

For more  flexible  work  with  the  file  lists,  please,  use  the
"Sessions" script.

 



Open If

This script  opens  multiple  graphic  files  meeting  user  defined
specs.

1. First off, choose a source folder.

2. If necessary, define some size-related parameters. For example, "Area
greater than  8  Mpx",  or  "Width  greater  than  Height"  (that  is,
"landscape-oriented" images).

3. In the third section, you can specify when the sought-for snapshots
were taken. For example, on the screenshot the search range is limited
to the night photos.

4. In the  fourth  section,  you  can  define  the  camera- and lens-specific
options.

5. Click the "Open" button to start the search.

Open Next / Previous File

Suppose you need to quick-edit 200  or  300  photos  just downloaded
from your camera to the hard drive. In such a workflow, choosing and
opening the next file may take almost as much time as the editing itself.

The script  "Open Next  File" finds the  next  file  in the same folder
as the  current  document.  For  example,  if  you  are  working with a
document named "DSC_0151", the script opens file "DSC_0152".

Accordingly, the  "Open Previous File" script  opens  the image file
"DSC_0150".

The scripts "Close, Open Next" and "Close, Open Previous", not
only let  you jump  to  the  next/previous image,  but also close the current
document without saving.

Tip. For even quicker access to the next/previous file consider adding
the above scripts either to Effects (fig. 1) or to Actions panel (fig. 2).



Save All

This script automatically saves all the opened documents as follows:

1. First, it tries to save each file with the original name and extension.

2. In case it's impossible (for example, you might open a JPEG file and add a layer), the script saves the
file into the original folder, but with PSD extension.

3. At last, if the document has been recently created and hasn't been saved yet, the script saves it as
PSD file into "~My Documents > PSE Auto-Saves" folder.

 

           Save for Web All

It is generally known that the "Save for Web" tool outputs smaller
files, than those saved via "Save" or "Save As" command.

The "Save for Web All" script exports all the opened documents to Web-
friendly formats.

1. From the "Scripts" dialog launch the "Save for Web All" script.

2. In the  dialog  box that  opens,  click  the  "Browse"  button and choose a
directory where  you  wish  to  save  the  Web -optimized copies  of  the
original images.

3. In the  "Output  File  Options" area,  choose  a format and  adjust  its
optimization settings.

4. The "Overwrite existing files" option lets you stipulate, what to do if a
file with the same name already exists - skip saving or overwrite.

5. Click the "Run" button.

To save for Web, an entire folder of photographs, you use the "Batch"
tool:

1. Open any image.

2. Run the  "Save  for  Web  All"  script,  choose  the  destination folder,
format, and optimization options.

3. Click the "Save and Close"  button  to make the script remember
your settings.

4. Open the "Batch" dialog.

5.  Select for execution the "Save for Web -batch edition" script.

6. Choose the "Source" directory and "Destination" options.

7. Choose the source directory and "Destination" options.

 



Revert All

"Revert All" script returns all the currently opened files to the last saved version.

Sessions

If your projects require opening the same sets of files
over and over again, you may need a session manager.

The "Sessions"  script  lets  you  save  lists  of  the  currently
opened files  and  batch -open images  from  the  previously
saved sessions.

To save a session:

1. Launch the "Sessions" script.

2. Optionally, edit  the  name  in  the  "Current  session"  field
(otherwise, the session will be named after the current date
and time).

3. Click the "Save" button.

To load a previously saved session:

1. Choose an item from the "Saved sessions" menu.

2. Click the "Load" button.

To delete an unnecessary session:

1. Select it in the "Saved sessions" menu.

2. Click the "Trash"  button.

 



"Landscapes" Category

These scripts facilitate some tasks that may appear while editing the landscape photos.

 

           Cloud Booster

This scripts tries to emphasize the clouds by increasing
contrast in the image highlights.

After applying the script you can strengthen or fade the effect
by changing the opacity of the "Cloud Booster" layer.

If you  need  to  hide  the  unnecessary  parts  of  the "Cloud
Booster" layer paint on the mask with black color.

And vice  versa, by painting  on the  mask with  white color you
can spread the effect to the yet untouched areas.

 



Faux Sun

Sometimes the sun spoils the photo with a formless white patch. One
of the possible ways of saving the image is painting a sun from scratch.

If you can't do it on your own try the "Faux Sun" script.

1. In the middle of the white spot, select a circle with the  Elliptical
Marquee tool (fig. 1).

2. Launch the "Faux Sun" script.

3. It opens the "Color Picker" dialog. Choose the most suitable color for the
area around the sun's disk (fig. 2).

The color should be neither too light (otherwise the white sun won't stand out
against it) nor too dark.

4. In case the color you've selected is visible on the areas it's not supposed to
fill, hide the unnecessary parts by painting on the mask of the "Sun" layer
with black color.

5. To adjust the fill color afterwards, double-click the thumbnail of the "Sun"
layer.

6. To fade the produced effect reduce the fill layer opacity.

7. Also, you can adjust the sun disk edge sharpness by changing the "Feather"
value in the "Masks" dialog.



Mist

This script creates a band of fog that adds an
air of mystery and/or hides the image
shortcomings.

To create the mist under or above the image center,
roughly mark the desired horizontal axis with the 

 Rectangular Marquee tool prior to running the
script (fig. 1).

After applying the script you can adjust the fog
density with the layer opacity slider (fig. 3).

Grad ND Filter

This script imitates a graduated neutral
density filter darkening the upper half of the
picture.

To adjust the size of the darkened area after using
the script, just press [Ctrl+T] keys.

To change the filter density, adjust the opacity of
the "Grad ND Filter" layer.

 



Pseudo HDR

This script imports into the document several copies of
the same RAW-file, thus facilitating creation of a pseudo-HDR
image.

Suppose we can see that the background of the opened RAW
photo is well exposed, the foreground is too dark, and the sky
is too light.

1. So, launch the "Pseudo HDR" script. The source file reopens
in the Adobe Camera RAW (ACR) dialog window.

2. Increase the "Exposure" value to make the image
foreground lighter and click "Open Image" button.

3. The photo opens in the ACR window for the second time.
Reduce the exposure value as to develop the sky detail and
click "Open Image".

4. Now we've got all we need from the source file, so, when the
ACR opens for the third time, click "Cancel" button* and the
script is finished.

*Again, you stop the script by pressing the "Cancel" button in
the ACR dialog. Without interruption (i.e., if you press "Open
Image" every time the dialog opens), the script stops by itself
after importing four layers.

Now the pseudo-HDR document created by the script contains
three layers. The far end of the island is well exposed on the
"Background" layer, the foreground trees look the best on the
"Layer 1", while the most detailed sky is on the "Layer 2".

So, we have to mask the improperly exposed areas of the
"Layer 1" and "Layer 2" as shown on the screenshot.



Sky Rescue

The blown-out sky is a fairly common problem for many
photographers. The "Sky Rescue" script fills the lightest areas
of the image with light blue color.

If you don't like the result, double-click the thumbnail of the
"Sky Rescue" layer and adjust the fill color.

If the blue color is visible in the areas it doesn't belong to, hide
the unnecessary parts by painting on the mask of the "Sky
Rescue" layer with black color.



Star Trails

 

This popular effect is based on the apparent daily
rotation of the stars. By combining several dozens or even
hundreds of starry sky shots we can visualize the star
trajectories during the photo session.

The "Star Trails" script automates loading and blending the
source pictures into a composite image.

1. In the "Source" drop menu, specify which files should be
loaded - all the currently opened documents (Open Files),
not opened files from your computer (Selected Files), or a
whole folder with images (Folder). The two latter options
open a dialog for choosing the source folder or files.

2. "Fade in" option (fig. 2) adds to the trails a comet-like
effect (fig. 2*).

3. To turn the "comets" in the opposite direction (fig. 3*),
check "Reverse Order" gadget (fig. 3).



Sunburst

This effect mimics the sun rays breaking through foliage, clouds,
etc..

1. Run the "Sunburst" script (fig.1).

2. Move  the "sun" (the "Sunburst" layer) to a suitable place in the
image (fig. 2).



"Photo Effects" category

The "Photo  Effects"  category  is intended for
the scripts  creating various  visual  effects  or solving
some common photographic issues.

The most  scripts  from  this  category that come with
E+ can be used for the batch processing.

Aged Photo

This script imitates an old, faded, and yellowed photograph.

 



Cross Processing

This script  reproduces  the popular effect  of the same
name sometimes also associated with lomography and Lo-fi
photo.

deUnderwater

This script is meant for improving color in underwater 
photos.

Dodge-n-Burn

This script imitates the popular editing method of the
same name,  by lightening  the  darker areas  and darkening the
lighter ones.

The script  is  intended  as  a  fully  automatic  effect.  In the
meantime, if you are not happy with the achieved result you
can fine-tune it to your taste.

If the  picture  looks  flat  or  if  there  are  strong  halos, open
"Smart Filters" dialog, double-click the "Smart Filter 1", and
adjust the image view with "Radius" slider.

Also, you can fade the effect by reducing opacity of "Dodge-n-
Burn" layer.



Fill Flash

 

This script lightens the darkest areas of the image.

After creating this effect, you can intensify or fade it by
changing the opacity of the uppermost layer.

Film Grain

 

The "Film Grain" script is a yet another "analogue"
effect imitating grainy film.

By default, the created grains are monochromatic. If you need
the color noise, change the "Film Grain" layer's blending
mode from "Luminosity" to "Normal".

 



Illustration

 

This script modifies photographic images to resemble a
book illustration.

If you wish to strengthen the effect, just play the script twice.

To fade the effect, reduce the opacity of the layer added by the
script.

Lens Vignette

 

 

The "Lens Vignette (corners)" script imitates
"vignetting" by darkening the image corners.

The "Lens Vignette (rectangle)" version creates the
same effect along the image perimeter.

To fade the effect, reduce the adjustment layer opacity.

 



Looks
Suppose, while  editing  an  image,  you  made  a  very  complex

correction and  now  you  want  to  save  this  cool  effect  for  later use.
Another example: you need to automate a routine adjustment, say, some
standard pre-print corrections.

In both cases, you may rely on the "Looks" script:
- To save the current image adjustments, you open "Looks" dialog and
click "Save" button.
- To apply a saved preset (aka "look") to another image, open the "Looks"
dialog and double-click the required item in the list.

Now let's look at the script in more detail.

1. To  enable  saving  color  and  tonal  corrections,  accomplish  those as
separate adjustment layers ("Levels, "Color Balance", etc.). If the edited
document contains fill layers ("gradient", "solid color", or "pattern"), they
will be included into the "look" as well.

2. The layer styles, blending modes, and opacity settings of the source
adjustment layers are also to be saved.

3. To add a filter (e.g., sharpening or artistic one) into the saved preset,
create it  with  the  help  of  "Smart  Filters"  script. In  case the currently
selected layer  is  not  a  smart  object,  a  smart -object will  be created
automatically.

4. To exclude some layers from the look, just hide them by clicking the
corresponding "eye"   on  the  Layers  panel.  Excluding  the
"Background" layer isn't necessary.

5. Now that your corrections are ready for saving, run the "Looks" script,
click "Save"  button,  and  enter  a  descriptive  name  for  the  new  loo k.
 
Optionally, you can  save a  look from  the  Actions  panel,  as shown in this
video.

The correction  presets  get  saved  in  PSD  format  to
"C:/Elements+/15.0/Required/Looks" folder. By default, to  reduce  the
file size, the script uses very small pixel dimensions. The raster, text, and
shape layers, as well as layer masks, are normally excluded.

6. "Do Not Reduce" checkbox lets you save full-sized PSD's with all the
layers (except for  the  hidden  ones)  and masks. You may use  this option,
for example, for creating a template with a frame, clip art, text, logo, or
similar elements.

While using this approach, please, keep in mind the following:
- Such a template is usually bound to a specific image size.
- Large PSD images may require a huge amount of disk space.

7. "Make  Script"  option -- along with  saving a look -- creates a script for
applying the preset without opening the "Looks" dialog. You may need it,
e.g., for batch processing of a whole folder of photos.

Applying the saved looks is very easy:

8. Open an image of your choice.

9. Run  the  "Looks"  script.  In the  dialog  that  opens,  choose  the  required look in  the  list.  
Then either  click  "Apply"  button  or double-click the required item in the list.

Alternatively, you can load a look with "Apply Look" action.



Puzzle

 

 

This script converts the image in a kind of 
jigsaw puzzle.

To fade the created effect, reduce the opacity of the "Puzzle"
layer.

Velvia

 

This script mimics the once popular "Velvia" film,
known for the high contrast and the saturated colors.

After playing the script, you can adjust the image tone by
editing the setting of the "Levels" layer.

The color saturation can be faded by reducing the opacity of
the "Saturation" layer.



"Portraits" Category

You may find these scripts helpful for the portrait editing / retouching.

  

               Frequency Separation

This script prepares the layers required for the frequency
separation method for skin retouching.

By default, all the parameters of the applied filters are defined
automatically. If you want to set the skin smoothing amount manually,
hold down [Shift] key while starting the script.

As result, you get three layers: the "Shapes" layer contains the blurred
image, the "Details" layer is responsible for the finer details, while the
skin texture appears on the "Textures" layer.

Now you can hide the skin imperfection yet in the meantime retaining
its natural texture.

- Choose a soft brush  and reduce the stroke opacity. 
- Make sure that the "Details" layer is selected and that its mask is
active.
- Paint with black color to smoothen the skin.

If you need to remove the smoothing effect from certain areas, clear
them with the Eraser  tool.

 



Gentle Glow

 

This script creates a soft studio-light-like effect.

By default, the script runs silently. If you wish to customize its
settings hold down [Shift] key while launching the script.

After applying the script, you can fade or strengthen the
achieved effect by adjusting opacity of the "Gentle Glow"
layer.

Iris Cleaner

This script helps you to "clarify" the eyes on a photo by
increasing the iris brightness and contrast.

Please notice, that this method is mainly intended for the lighter
eyes, so it may not work well for the dark or poorly lit ones.

1. Select on your image the iris areas with the Quick Selection (fig. 1)
or some other tool.

2. Run "Iris Cleaner"  script.

3. In the "Levels" dialog that opens, adjust the iris tone if needed.

4. Evaluate the result and -- in case the eyes look too bright -- fade
the effect by increasing the opacity of the uppermost layer (fig. 2).

 



Retouch Layer

 

This script creates a special layer facilitating the skin
smoothing.

By default, the softening extent is defined automatically. If
you wish to customize it hold down [Shift] key while
launching the script.

After using the script, paint on the mask of the "Retouch"
layer with white color to smoothen the skin.

Rouge

 

If you think the model's skin on your photo is a bit
pale, give a try to the "Rouge" script.

1. Select a small portion of the skin that you want to redden
with any selection tool (fig. 1).

2. Launch the "Rouge" script.

3. Choose a soft brush and reduce the stroke opacity.

4. Paint over the mask of the "Rouge" layer to apply the
blusher (fig. 2).

5. If you don't like the color suggested by the script, double-
click on the thumbnail of the "Rouge" layer and fine-tune the
color.



Skin Care

 
This script smoothes the skin automatically.

By default, it runs silently. If you wish to customize the
settings, hold down [Shift] key while launching the script.
Then, in the "High Pass" dialog that opens, adjust the
"Radius" value.

After applying the script, you can fade or strengthen the
achieved effect by adjusting opacity of the "Skin Care" layer.

To retain the sharpness of the eyes and other key ares, paint
on the mask of the "Skin Care" layer with black color.

Soft Filter

 
This script imitates softening photo filter.

By default, it runs silently. If you wish to customize the
settings, hold down [Shift] key while launching the script.
Then, in the "Gaussian Blur" dialog that opens, adjust the
"Radius" value.

To fade or strengthen the achieved effect, adjust the opacity
of the "Soft Filter" layer..

To retain the sharpness of the eyes and other key ares, paint
on the layer mask with black color.



"Resize" Category

The "Resize" category is intended for the scripts altering the document size or resolution.

 

    All Resolutions

 This script lets you set the resolution (that is, "dots per
inch" value) for all the currently opened documents.

Extend Canvas

The "Extend Canvas" script creates a simple one-color frame by increasing canvas size.

1. In the  Toolbox,  click  the  "Background Color" box and choose 
a color for your frame.

2. Run the "Extend Canvas" script.

3. In the dialog box that opens, set the canvas extension in pixels
for each side of the document.

4. To frame all the opened images, check the "All open images"
gadget.

If you want to frame an entire folder of photographs, you use the
"Batch" tool:

1. Open any image.

2. Run the "Extend Canvas" script and set the canvas extension
values.

3. Click the  "Save  and  Close"   button  to  make  the  script
remember your settings.

4. Launch the "Batch" script.

5. Select for  execution  the  "Extend  Canvas  - batch edition"
command.

6. Choose the source directory and "Destination" options.

7. Click "Run" to start the batch processing.



Fit Size

This tool has the same purpose as "Fit Image" script coming
with Photoshop Elements - it adjusts images of any proportions to
the specified dimensions. In the meantime, it offers more
opportunities for batch processing.

Let us suppose that we create a Web gallery from landscape- and
portrait-oriented photos, and the both types mustn't exceed 400 x
300 pixels limit. To automate this task we use the "Fit Size" script.

1. From the "Scripts" dialog, launch the "Fit Size" script.

2. In the dialog that opens, enter the maximum allowable
dimensions values in the "Max. width" and "Max. height" fields.

3. By default, if the initial size of the edited document is smaller
than maximum allowable values, the script doesn't resize it. To
force resizing all of the images to specified dimensions, check the
"Scale up if smaller" gadget.

4. The "Fit all open images" option lets you process all of the
currently opened documents.

If you need to resize, for instance, an entire folder of photographs,
you use the "Batch" tool:

1. Open any image.

2. Call the "Fit Size" dialog and define the maximum allowable
width and height.

3. Click the "Save and Close"  button to make the script
remember your settings (fig. 1).

4. Launch the "Batch" script.

5.  Select for execution the "Fit Size -batch edition" script (fig. 2).

6. Choose the source directory and "Destination" options.

7. Click "Run" to start the batch processing.



Fit Area

This script adjusts the document size to a specified
area.

1. In the "Fit Area" dialog, enter the desired area value and
choose the proper units - "px" (pixel) or "Mpx" (megapixel).

2. By default, if the initial area of the edited document is
smaller than the target value, the script doesn't resize it. To
force resizing the image anyway, check the "Scale up if
smaller" gadget.

3. The "Resize all open images" option lets you process all of
the currently opened documents.

4. Click "OK" to start the resizing.

Fit Print

This script adjusts the "Document Size", as opposed to the "Pixel
Dimensions" values displayed in the "Image Size" dialog.

1. In the "Max. width" and "Max. height" fields, enter the maximum
allowable print sizes. Also, be sure to choose the proper units.

2. The "Allow rotation" option makes the script turn the document in
case its orientation mismatches the specified width-to-height ratio.

For example, a portrait oriented image will be turned if "Max. width" is
greater than "Max. height".

3. By default, if the initial "Document Size" values are smaller than the
target print size, the script doesn't change them. To force resizing all of
the images to specified dimensions, check the "Scale up if smaller"
gadget.

4. The "Resample Image" option allows the script altering the pixel
dimensions. If this option is disabled, the script is only allowed to re-
calculate the "resolution" (dpi) value.

5. The "Change resolution" option lets you specify the document's "dots
per inch" value.

6. The "All open images" gadget makes the script resize all the currently
opened documents.



Hide Cropped

While cropping an image in the full Photoshop, the
users can decide what to do with the cut areas - completely
delete or just hide outside the document edges.

Unfortunately, Photoshop Elements users haven't got such a
choice, so the cropped parts get irretrievably deleted anyway.

In case you're not 100% sure which areas of your photo
should be discarded try the "Hide Cropped" script:

1. Launch the "Hide Cropped" script.

2. Apply  the cropping.

If, during the further work, you change your mind, adjust the
layer position with the  Move tool.

To get all the cut areas back, apply the "Image > Resize >
Reveal All" command.

Please, note that PSE remembers this setting and applies it
whenever you use the  Crop tool.

To restore the default operating mode, choose "Reset Tool"
command on the Options panel.



Measure

The "Measure" script can measure distances and angles, calculate
areas, and level images.

For example, if you want to calculate an object's area:

1. In case the object is in separate layer, select it in the Layers palette.
The screenshot 1 exemplifies measuring a text layer "Contact us".

2. Or select some portion of the image with a selection tool.

3. Run the "Measure" script.

4. Choose the desired units (fig. 1) and read the result in the "Area" line.

How to measure the distance between two points:

1. Activate the Rectangular Marquee tool and drag with it from the
starting to the ending point. On the screenshot 2, the author measures
the distance between the duck's eye and the tip of the beak.

2. Run the "Measure" script.

3. Choose the units and read the distance value in the "Diagonal" line.

How to level the image off:

1. Drag with the Rectangular Marquee tool along a presumably
horizontal or vertical line. For example, on the screenshot 3, the author
takes the coastline as horizontal.

2. Open the "Measure" dialog.

3. The image slope is already measured here, so you only have to click
either  "Turn right" or  "Turn left" button (fig. 4).

4. Cut the uneven margins with the Crop tool.

 



Multi-Export

Suppose you need to save several versions of the edited image: a
full-size copy for a photolab, a reduced copy for TV screen, the third
image for uploading to the photo hosting A, and the fourth one for the
photo hosting B.

The "Multi-Export" script can accomplish this in seconds.

1. In the uppermost panel of the dialog window, choose a destination
folder and, optionally, change the file name.

2. Check the "Enabled" gadgets next to the sizes you want to export
your image to.

3. Enter the target widths and heights in the corresponding fields of the
"1" through "4" panels*. The panel number "0" is reserved for the
current image size.

By default, these values mean the maximum allowable dimensions, so
the image should be resized without cropping (see "Fit Size").

4. If you want the image to be automatically cropped to the target size
(see "roboCrop"), check the  gadget.

5. Set the image quality for each saved size. (Only JPEG format is
supported.)

6. Check the "Metadata" checkboxes if you want to keep the EXIF,
copyright, and other metadata.

As default, all the exported files get saved to the same destination folder
with the pixel dimensions appended to their names. In the example
shown on the screenshot: "boats.jpg" (original size),
"boats_1920x1080.jpg", and "boats_900x596.jpg".

7. If you prefer saving each image size separately, click "Use subfolder"
checkbox and enter the subfolder name into the text field.

8. The "Export all open images" option lets you save multiple copies of
all opened documents at once.

9. Click "Run" to start exporting.

*When you open the "Multi-Export" dialog for the first time it contains
3 size-fields. Use "+" and "-" buttons at the bottom to add / remove
fields.



roboCrop

The "roboCrop" crops the images automatically.

1. In the "roboCrop" dialog window, enter the desired "Width" and
"Height" values.

2. In the "Units" menu, choose the proper option:

- If you select the "proportions" (fig. 1), the script merely fits the
image to a specified ratio by cutting the excess parts.

- If you select the "pixels" option (fig. 2), the script changes both the
ratio and the pixel dimensions of the image.

3. The "Crop" menu lets you pre-define, which kind of images should
be cropped - only landscape, only portrait, or any ("crop anyway").

4. The "All open images" option makes the script to crop all the
currently opened documents.

If you want to crop a whole folder of images - for example, to make
them fit into an HD screen - use the "Batch" tool:

1. Call the "roboCrop" dialog and enter the desired values (fig. 2).

2. Click the "Save and Close"  button to make the script remember
your settings.

3. Launch the "Batch" script.

4.  Select for execution the "roboCrop -batch edition" script.

5. Choose the source directory and "Destination" options.

6. Click "Run" to start the batch processing.



Smart Resizer

If you happen to resize the edited images repeatedly, pay your
attention to the "Smart Resizer".

Prior to the first resampling, the script creates a smart object,
containing the original document (on the screenshot,
"_DSC8464.NEF/4778*3165").

Since this object keeps the initial image data, the followup
transformations don't necessarily result in a loss of quality.

That is, you may reduce such an object 20 times, and then change
your mind and losslessly increase it to the original dimensions.

The resampling algorithm is defined automatically. For minor
resampling (up to 20%), the script selects the "Bicubic" method; for
more substantial upscaling - "Bicubic smoother"; for significant
downscaling - "Bicubic sharper".

Furthermore, to compensate the possible loss of sharpness, the script
applies to the smart object the "Unsharp Mask" filter. The filter
settings are calculated automatically, based on the image size and
the scaling ratio.

To disable the auto-sharpening, uncheck the "Sharpen" checkbox.

If you prefer to adjust the sharpening parameters manually check the
"Display filter settings" gadget.

Or you can adjust those settings afterwards by using the "Smart
Filters" tool.



Split Reduction

As we know, the "Bicubic sharper" algorithm is recommended
for avoiding the sharpness loss during the image reduction.

In certain cases, though, a significant downscaling using this method
may result in obvious oversharp. Isn't the "Bicubic" algorithm more
secure?

To not bother about this issue, the "Split Reduction" script combines
the both methods.

Once launched, the script opens the dialog very similar to the "Fit
Size" tool.

Enter the maximum allowable dimensions values in the "Max.
width" and "Max. height" fields and click "OK".

As result, you get a properly sized document that contains two layers
- "Bicubic" and "Bicubic sharper". Now you can visually compare and
select the better version.

Furthermore, you can combine the both algorithms by reducing
opacity of the "Bicubic sharper" layer and/or by masking the
oversharped areas as it is shown on the screenshot.



Square It

This script makes any image square, by cutting off the
excess areas. In a certain sense it's a simplified version of the
"roboCrop" with the only option available - cropping to 1:1
ratio.

The script is suitable for the batch processing.

Trim

This command crops the image automatically, by
cutting off continuously colored or transparent areas.

1. Run the "Trim" script.

2. In the dialog box that opens, define which areas should be
cropped - transparent, top left pixel color, or bottom right
pixel color.

3. Specify, which edges to be trimmed. On the screenshot, the
author crops all the edges except for the bottom one.

4. Click "OK" to commit the trimming.

 



Warp Presets

 

Perhaps, you've already used "Warp Text"

feature for transforming type layers into the shape
of an arch, wave, or fish.

Now you can warp in this way any layer or selected
area (screenshot).



"Sharpen" Category

The "Sharpen" category includes the scripts imitating image focusing.
 

                      Sharpen Soft / Hard / Vivid / Linear

                                                        These four scripts, actually based on the same algorithm, only differ in the sharpening degree that grows 
                                                        from "1" to "4".

 1. Sharpen Soft (the softest)

2. Sharpen Hard (sharper)

3. Sharpen Vivid (even sharper)

4. Sharpen Linear (the sharpest)

All the  scripts  are utterly  automatic and  don't require user
participation. After playing the scripts, you can fade the effect
by reducing the "sharpening" layer opacity.

Edge Mask

 
This script  utilizes  a  variation  of  the  well-known

sharpening method with the help of the "edge mask".

 



Focus Stacking

 Combining a series of photos into a single image is often used for
achieving a  deeper  depth  of  field.  "Focus  Stacking"  script  lets you
accomplish this trick with a single click.

1. So, you  beging  with taking  a  series  of  pictures  with  different focal
points. (Using a tripod is strongly recommended.)

In the  example  shown on the  screenshot 1,  the camera was first focused
at the  blue  pencil  (photo  "DSC_2806"),  then  at  the  green  pencil
("DSC_2807"), and at last, at the red one ("DSC_2808").

2. Open the taken pictures (and only them) in the PSE Editor.

3. Run "Focus Stacking"  script.

The result of combining the sample photos is shown on the 
screenshot 2.

Please, keep in  mind  that  this method  is  a huge memory hog. When
stacking many  photos,  you  may  need  to  reduce  their  size  prior to
running the script.



Noise Stacking

This script removes the noise by "averaging" a photo
series.

Suppose, you are shooting handheld in the dark, at a very
high ISO level. To get a clean picture, please, try the
following.

1. Instead of a single snapshot, take several identical photos
(fig. 1) by using your camera's burst shooting mode.

2. Open the taken pictures (and only them) in the PSE Editor.

3. Run "Noise Stacking"  script.

The resulting image includes two
layers (fig. 2): 
- the upper layer (Noise Stacking)
contains the denoised image;
- the lower layer is the original non-
edited photo (the file that was
selected prior to the script launch).

In case the source pictures contain
some moving objects (e.g., cars), they
may be merged together. To get rid of
those artefacts, erase or mask the
corresponding areas of the upper
layer.



FS-Sharpener

As we know, frequency separation is a retouching technique,
allowing to smoothen image details selectively. "FS-Sharpener" helps us
to use the same method for very efficient sharpening. (Yes, "FS" in the
script name stands for "Frequency Separation".)

1. Run  "FS-Sharpener" script.

After dividing the image to frequency-layers the script activates the
mask of the "Textures" layer, chooses the Brush  tool and makes
the foreground color white. Now you only have to choose a soft brush tip
and set the stroke opacity to 30% or so.

2. Paint over the places you want to sharpen (fig. 1).

3. If you need to remove the sharpening effect from certain areas, clear
them with the Eraser  tool.

4. In case the achieved sharpness isn't sufficient for you, activate the
mask* of the "Detail" layer (fig. 2) and paint over it  with white
color (fig. 1).

*Just in case you forgot, you activate the mask by clicking the second
(right) thumbnail of the corresponding layer in the Layers panel (fig. 2).

Local Contrast

This script uses specific parameters of the "Unsharp Mask"
filter to increase the local contrast.

By default, the script runs in silent mode. If you want to customize
the filter settings hold down [Shift] while starting the script.

As result you get two layers allowing you to handle "lightening" and
"darkening" aspects of the image contrast individually.

For example, if you find the overall image too bright, reduce the
opacity of the "Local Contrast (Lighten)" layer.

Or, if you noticed too dark spots, click on the mask thumbnail of the
"Local Contrast (Darken)" layer and paint over the corresponding
areas with black color.



Sharpen Luminosity

As we know, sharpening filters may cause chromatic
aberrations. That's why many Photoshop users resort to such
a workaround:

- Converting the image to Lab mode.
- Sharpening the L (Lightness) channel with the "Unsharp
Mask" filter. 
- Reconversion to the initial color mode.

The "Sharpen Luminosity" script uses an alternative version
of the described method adapted for PSE.

1. So, run the "Sharpen Luminosity" script.

2. Define the suitable "Unsharp Mask" values with the sliders
and click "OK".

Split Sharpness

This script lets you manipulate the image sharpness
separately in the dark and light areas.

By default, the script runs in silent mode. If you want to
customize the filter settings hold down [Shift] while starting
the script.

As result you get two layers allowing you to adjust "lightening"
and "darkening" aspects of the sharpening effect.

For example, reduce opacity of the "Sharpen (light)" layer to
fade the lighter noise caused by the sharpening.

To remove either the dark or light sharpening from a specific
part of your image, click on the layer mask thumbnail and
paint over the corresponding areas with black color.



"Text Effects" Category

 
There are no prizes for guessing that the "Text Effects"

category includes miscellaneous text effects.

Most of the scripts mentioned in this section require an active
type (T) layer.

Aerograph

 
 This script reproduces the "airbrushing" effect.

1. Select the proper layer in the Layers palette.

2. Launch the "Aerograph" script.

3. In the "Gaussian Blur" dialog that opens, adjust the
"spraying" result with the "Radius" slider.

4.  Afterwards you will be able to edit the effect with the help
of the "Smart Filters" tool.

 



Drunk Characters

 

 This script makes the text "dance" by varying each
letter's position, size, and color at random.

To achieve this, the script splits the source type layer to
individual characters (the same way as the "Split to Chars"
does it).

Easy 3D (deep / shallow)

 

These two scripts let you create a 3D-like effect with a click.

 The only difference is that the "Easy 3D (deep)" adds
wider facets,

while the "Easy 3D (shallow)" creates narrower facets.

Meanwhile, after playing the script you can adjust the edge
width and position by nudging the "Easy 3D's edge" layer.

The color of the created facet depends on the Background
color chosen in your Toolbox.

 



Graffiti

 
This script wraps text (or any other kind of a layer)

around a surface / texture on the backward layer.

As rule, you get the best result with very light letters on a
contrasting background.

In some cases, you can dramatically improve the result by
playing with the opacity of the created layers - either
"Overlay" or "Soft Light".

Quick Reflection

 

 This script imitates reflection of the source layer from
a horizontal surface.

Quick Shadow

 
 This script creates a shadow behind the current layer.

After playing the script you can adjust the shadow position by
nudging or deforming the "Text's shadow" layer.

To tune the shadow density, alter the layer opacity.



Split to Chars

 

 This script divides the source text layer to symbols.
This lets you, for example, change each letter's position
individually.

Please note that the script playback duration depends on the
image size and the number of characters.

Split to Lines

 

 

 This script divides the source text layer to separate
strings, which enables you to edit them individually.

 



Split to Words

 

 

 This script divides the source text layer to words,
which can be edited individually.

V-Stitches

  This script "sews" your text on the image.

The script opens the "Color Picker" dialog, allowing you to
specify the "stitch" color.

After playing the script, you will be able to change this color
by clicking the "stitches" layer thumbnail.

 



"Tweaks" Category

The "Tweaks" category includes the scripts intended for editing either Photoshop Elements    
           or Elements+ settings.

 

   E+ Options

 The  "E+ Options"  script  allows  you to  change some
Elements+ settings.

More detail is available in other parts of this documentation :

About choosing E+ interface language
About resetting E+ dialogs

 



fx Commander  

 This script is designed for managing the "actions" (Photoshop
macros) that appear on the "Photo Effects" tab of the Effects panel.

The script interface is divided in two halves:

1. The panel  to  your  left  displays  the  contents  of  the
"...\ProgramData\Adobe\Photoshop Elements\15.0\Photo
Creations\photo effects"  folder, that is, all  the actions  available in
PSE.

To navigate  the effect  categories  you  use  the  drop  menu over the
actions list (fig. 1).

To see all the effects from all the categories simultaneously, check
the "All Categories" gadget under the actions panel.

2. The panel  to  your  right  displays  all  the  currently  applicable
commands.

How to  add  to  your  Effects  a  new  action  (*.ATN  file),  e.g.,
downloaded from the Internet:

1. In case the ATN file is provided with a PNG thumbnail and a XML
metadata file  (that is, if the action is already properly prepared for
PSE), unpack/copy all the three files into the same folder.

 

If such PNG  and/or  XML  files  aren't  available,  the script will add
them automatically.

2. Launch the "fx Commander"script.

3. In the Commands panel, double-click the "Import Action" line.

4. In the "Name" field of the dialog that opens, edit, if necessary, the
text that will be displayed in the Effects panel.

5. In the "Category" menu, choose a target category for the effect.

To create a new category, select the "New Category..." item and enter
some name in the text field that appears (fig. 2).

6. Press "OK" to add the effect.

 

Important! The changes will be displayed in the Effects panel after
re-building the PSE cache file.

How to manage the existing actions/effects:

1. Select an effect in the left panel.

2. Double-click a command in the Commands panel. 

 

 

 



The "Rename Action" command lets you alter the action name
displayed in the Effects palette.
The "Move Action" command changes the category, where the
selected action will appear.
The "Duplicate Action" command lets you create a copy of the
selected effect  with  a  different  name  and/or  in  a different
category.

The screenshot 3  exemplifies  moving  the  "Color Mixer" script
from "Special FX" to "Elements+" category.

The "Delete Action" command removes the selected effect.

The following batch of commands is intended for handling the effect 
thumbnails:

The "Edit Thumbnail" command merely opens the selected action's thumbnail for editing in PSE.
The "Replace Thumbnail" command lets you replace the current thumbnail of the selected action with 
another image. In case the graphic file hasn't been formatted properly, the script will do it automatically.
The "New  Thumbnail..."  command  creates a new thumbnail from  the  currently active  document. 
In case an action is selected at the moment in the left panel, the script will suggest replacing its 
 thumbnail with the just created one (fig. 4).

 

As we  already  know,  any  changes  made  with  the  "fx  Commander"  will  take  place  in  the  Effects panel only 
after rebuilding the  PSE  cache -file (MediaDatabase.db3).  Since,  in  the  Windows  environment,  we  can't  delete  
it while Photoshop Elements is working, the author suggests the following workaround:

1. Complete all the required action manipulations.

2. Apply the "Reveal MediaDatabase" command that opens the "cache" folder in the "Explorer" window.

3. Quit Photoshop Elements.

4. In the "Explorer" window, delete the "MediaDatabase.db3" file.

5. Restart PSE and wait for the Effects to rebuild.

 

Please keep in mind that PSE caches the thumbnails in a separate file. So, to update the images in the Effects panel 
you have to delete this file as well:

1. Apply the "Reveal MediaDatabase" command.

2. Apply the "Reveal ThumbDatabase" command.

3. Quit Photoshop Elements.

4. Delete the "MediaDatabase.db3" file.

5. Delete the "ThumbDatabase.db3" file.

6. Restart PSE.



Goodies

This feature lets you easily add brushes, shapes, adjustment presets, and similar resources to PSE.

There are two way to use "Goodies":

1. Select the required resources in your file browser and drag them onto "Goodies+15" droplet.

The droplet must be available both on your Desktop and in the Downloads folder.

2. Alternatively, you can run the "Goodies" from the "Scripts" catalog. Then, in the dialog that opens, 
select the required files on your computer.

The script recognizes compatible file types and copies them into the proper folders.

The imported resources appear after PSE restart in the menu of the corresponding palette or dialog.



Hidden Prefs

This script grants you access to some undocumented Photoshop Elements preferences.

1. "Resize Image During Place" setting (fig. 1) specifies if the placed images should be scaled to fit the edited document.

2. When editing a very big document, file saving may interrupt your work for some time. "Save in Background" option
(fig. 2) lets you continue working while saving operation is performed.

3. To activate auto-recover feature, check "Automatically Save Recovery
Information" checkbox and select time interval in the drop menu 
(fig. 3).

Please, keep in mind that this feature doesn't auto-save the original file.
Instead, PSE creates a new file in the backup folder:
C:\Users\<UserName>\AppData\Roaming\Adobe\Photoshop
Elements\15.0\AutoRecover

In case  of  PSE crash,  on the  next  startup, you will be offered to restore
the edited documents.

Important: Some users of full Photoshop report occasional failures of
the automatic recovery system.  So, it  may be wise  to  not  rely solely on
this tool.

4. "Auto -Update Open  Documents" option  may  come  in  handy, for
instance, while editing  a shared image file  via local network. On saving
changes by one user, the open document automatically updates in the
collaborator's PSE window as well (fig. 4).

5. On opening an image, PSE creates a "history snapshot" allowing you
to return to the initial state even if the image has been re-saved.

However, while working with very large graphic files, you may decide
that the snapshot occupies way too much RAM.

By unchecking the "Automatically Create First Snapshot" gadget (fig. 5)
you make the sequence of backup states a little bit shorter (fig. 9).

6. As  we know, the  undo history  in  PSE is  linear, which means,  that making any changes for an "earlier" history state
undoes all the "subsequent" steps.

"Allow Non-Linear History" option let the "alternative branches" co-exist in your "History" panel (fig. 6).

7. By default,  for  any image size  changes  Photoshop Elements  relies  on the  "Bicubic" algorithm. While resampling an
entire image, we may choose in the "Image Size" dialog either "Bicubic Smoother" or "Bicubic Sharper" method. In the
meantime, we have no alternative when transforming a layer or selected area.

The "Image Interpolation" menu of the "Hidden Prefs" dialog allows you to choose the default algorithm for image



resampling. For  example,  if the  image upscaling  is  a  more  frequent operation in your workflow, you may want to
choose the "Bicubic Smoother" method, while for the downscaling you might prefer the "Bicubic Sharper".

In most cases, though, your are safe with "Bicubic Automatic" option that delegates the interpolation method choice to
PSE (fig. 7).

8. By default,  the  height  of  a  font  in  PSE is  measured in  "points".  In the  meantime,  the  point  itself  has two  different
definitions. One "PostScript" point is 1/72 inch, while one "Traditional" point is 1/72.27 inch.

Surely, in  most  cases,  the  0,3%  difference doesn't  matter much. However,  for  the  unerring  precision you may specify
the exact value in the "Point/Pica Size" menu (fig. 8).
 
 

   Menus+

This script lets you customize the main menu of Photoshop

Elements. For  example, you can  color the  most  used commands and
hide the unused ones.

1. Run "Menus+" script.

2. In the  drop  menu,  choose a  category  - - "File", "Edit", "Image",
etc..

3. Select a menu item in the list.

4. Choose a color for the selected item or hide it as it is shown on the
screenshot.

5. Once all the menus/categories are customized, click"Apply" button
to confirm the changes.

6. "Presets" menu lets you  save  and  load multiple versions of PSE
menu.

7. If you  want  to  return  the  standard  PSE  menu  select  in  the
"Presets" menu "Default" item and click "Apply".

Please, note  that  not  all  Photoshop  Elements  commands  are
available in  the  "Menus+"  dialog. The missing commands  cannot  be
customized.

 



Pref Presets

It is common knowledge that in the Preferences dialog lets us tune PSE to our specific goals. But what if our
workflow includes several kinds of tasks requiring different sets of preferences?

For example, while working with Web graphics:
- "pixels" are preferable for the both "ruler" and "type" units;
- "Bicubic sharper" is supposed to be the best interpolation algorithm when downscaling full-size photos for the Web
publications; 
- RAM issues don't matter, so the "Undo History" may contain up to 1000 states.

On the contrary, when working on a huge poster:
- you, most probably, choose "cm" or "inch" units;
- "Bicubic Smoother" is better suited for the image upsizing; 
- "History States" sequence must be as short as possible;
- you may need to allocate more memory (RAM) to PSE.

The "Pref Presets" script enables a quick-switch between the two (or more) sets of parameters.

The left panel of the script dialog contains the list of the previously saved presets. The last, additional, item in the list
represents the current program preferences.

The right part of the dialog window displays parameters of the currently selected preset. As you can see, not all the
possible preferences are included, but just the most useful ones (at least, in the author's opinion).

1. To choose a previously saved preset, just click the corresponding line in the presets list. Let's make it clear, that this
operation merely loads the settings combination to the right panel without affecting the current PSE preferences.

2. If necessary, you may alter the loaded parameters by using the sliders, checkboxes, and drop menus. This affects
neither the PSE preferences nor the existing pref presets.

Now you can use the displayed parameters in two ways - either apply or save.

3. The "Apply" button makes the currently displayed settings the Photoshop Elements preferences, just as if you
defined them in the "Preferences" dialog.

4. The "Save" button records the displayed parameters to a new pref preset. This doesn't affect the Photoshop Elements
preferences.

5. To delete an unnecessary preset, select it in the left panel and click the "Delete" button.

After saving the customized preferences, you can load them as follows:

1. Run the "Pref Presets" script.

2. Choose the required preset in the left panel.

3. Click the "Apply" button.



Script Events Manager

This tool sets scripts to start when certain PSE events occur. For example, you may use it to automate 
some routine tasks on creating a new document or on selecting a tool.

0. Launch  "Script  Events  Manager"  either from  the  Scripts catalog or  from  the PSE menu: 
"File > Automation Tools >  e+ Script Events Manager".
 
1. In  the  dialog  that  opens,  check  "Enable  Events  To  Run  Scripts"
gadget (fig. 1).

2. When first started, the script displays just a few events of "Favorite
Events" set. To load more events, choose a different category (fig. 2).

3. Select a trigger-event in the events list (fig. 3).

4. Choose either a  script  (fig.  4/1) or  an  action (fig.  4/2) that  should be
associated with the selected event.

 

Important: The  scripts menu displays  the  contents  of  "Events"
category. If  the desired script  is  not  on the list, choose "Browse..." item
and navigate to a JavaScript file in E+ catalog or some other location.

 

5. Click "Add" button (fig. 5) and make sure the new "Event: Script" line
is available in the upper list (fig. 5/2).

6. Once all the needed events/scripts added, click "Done" button (fig. 6)
to close the dialog.

Since the dialog contains hundreds of events, choosing the required one
may not be easy.

7. If  you  don't  know  which  category  the  required  event  belongs to,
choose "All Events" category (fig. 7).

8. In the search field, type at least 3 letters to filter the events (fig. 8).

 

Let's make  it  clear  that  not  all  Photoshop  Elements  commands are
available in  the  events list.  Some  steps  cannot  be detected by the Event
Manager. On the contrary, sometimes a single event corresponds to a
wide number of different activities, which makes it pretty useless as a
trigger.

9. Nevertheless, if you want to add a missing event (and if you know its code):
- Choose "Custom" category (fig. 9/1).
- Type a descriptive name for the new event (fig. 9/2).
- Type the event code (fig. 9/3) and, if necessary, its class (fig. 9/4).
- Click "Add" button (fig. 9/5).

10. To disable triggering a script, select the corresponding "Event: Script" line and click "Remove" button (fig. 10).

11. To disable all the trigger-events, uncheck the "Enable Events To Run Scripts" checkbox.



Shortcuts+

This dialog lets you streamline your workflow by customizing
PSE keyboard shortcuts.

Furthermore, the shortcuts can invoke some undocumented features
-- such as Curves and Soft Proof commands, etc.. Such "secret"
commands are marked with the "arrow"  symbol.

For the first use, it is recommended to select "Photoshop Keys" item
in the "Preset" menu. It loads a ready-made well-balanced shortcut
set mainly based on the standard "hot keys" of the full Photoshop.

To set a specific individual shortcut:
- Choose a command category in the top menu.
- Select a command in the main field.
- Choose the base key, as shown on the screenshot.
- If necessary, add [Alt] and/or [Shift] modifying key by checking the
corresponding checkbox.

In case the selected keystroke is already assigned to another
command, the dialog will  warn you. To reassign the shortcut,
click "Accept" button.

To save the modified shortcut set for later use, choose in the "Preset"
menu "Save" item. The saved set will appear in the "Preset" menu,
so, you can return to it at any time.

To restore the default PSE shortcuts, select in the "Preset" menu
"PSE Default Keys" item.

Important: To enable the modified shortcuts be sure to press "Apply"
button.

Bellow is "Photoshop Keys" shortcuts summary.

Commands:

File >
New... Ctrl+N
Open... Ctrl+O
Open in Camera RAW... Alt+Ctrl+O
Duplicate... Alt+Shift+Ctrl+D
Close Ctrl+W
Close All Alt+Ctrl+W
Save Ctrl+S
Save As... Shift+Ctrl+S

Alt+Ctrl+S
Save for Web... Alt+Shift+Ctrl+S
Scripts > Browse... Alt+Shift+Ctrl+O
File Info... Alt+Shift+Ctrl+I
Print... Ctrl+P



Exit Ctrl+Q
Edit >

Undo/Redo Ctrl+Z
Step Forward Shift+Ctrl+Z
Step Backward Alt+Ctrl+Z
Revert Shift+Ctrl+A
Cut Ctrl+X
Copy Ctrl+C
Copy Merged Shift+Ctrl+C
Paste Ctrl+V
Paste Into Alt+Shift+Ctrl+V
Paste in Place Shift+Ctrl+V
Fill Selection... Shift+Ctrl+F
Color Settings... Shift+Ctrl+K
Preferences >

General... Ctrl+K
Image >

Transform >
Free Transform... Ctrl+T

Crop Alt+Shift+Ctrl+X
Content-Aware Scale (=Recompose) Alt+Shift+Ctrl+C
Resize >

Image Size... Alt+Ctrl+I
Canvas Size... Alt+Ctrl+C

Enhance >
Auto Tone (=Auto Levels) Shift+Ctrl+L
Auto Contrast Alt+Shift+Ctrl+L
Auto Color Shift+Ctrl+B
Adjust Lighting >

Levels... Ctrl+L
Levels with Last Used Settings Alt+Ctrl+L
Curves... Ctrl+M
Curves with Last Used Settings Alt+Ctrl+M
Shadows/Highlights... Shift+Ctrl+H
Shadows/Highlights with Last used settings Alt+Shift+Ctrl+H

Adjust Color >
Hue/Saturation... Ctrl+U
Desaturate (=Remove Color) Shift+Ctrl+U
Channel Mixer... Shift+Ctrl+M
Channel Mixer with Last used settings Alt+Shift+Ctrl+M
Invert Ctrl+I

Layer >
New >

Layer... Shift+Ctrl+N
Layer (no dialog) Alt+Shift+Ctrl+N
Layer via Copy Ctrl+J
Layer via Cut Shift+Ctrl+J

Smart Object >  
Convert to Smart Object Shift+Ctrl+O

Create/Release Clipping Mask Alt+Ctrl+G
Arrange >

Bring to Front Shift+Ctrl+]
Bring Forward Ctrl+]
Send Backward Ctrl+[
Send to Back Shift+Ctrl+[

Merge Layers Ctrl+E
Merge Visible Shift+Ctrl+E
Stamp (Merge Visible into New Layer) Alt+Shift+Ctrl+E

Select >
All Ctrl+A



Deselect Ctrl+D
Reselect Shift+Ctrl+D
Inverse Shift+Ctrl+I
All Layers Alt+Ctrl+A
Refine Edge... Alt+Ctrl+R
Modify > Feather... Alt+Ctrl+D
Transform Selection Shift+Ctrl+T

Filter >
Last Filter Ctrl+F
Correct Camera Distortion Shift+Ctrl+R
Distort > Liquify Shift+Ctrl+X

View >
Proof Setup >

Custom (= Soft Proof) ... Shift+Ctrl+P
Zoom In Ctrl++

Ctrl+=
Zoom Out Ctrl+-
Fit on Screen Ctrl+0
Actual Pixels Ctrl+1

Alt+Ctrl+0
Show >

Selection Edges Ctrl+H
Grid Ctrl+'
Guides Ctrl+;

Rulers Ctrl+R
Lock Guides Alt+Ctrl+;

Tools:

Hand H
Zoom Z
Move V
Rectangular Marquee M
Elliptical Marquee M
Lasso L
Polygonal Lasso L
Magnetic Lasso L
Quick Selection W
Magic Wand W
Selection Brush W
Refine Selection Brush W
Eyedropper I
Crop C
Red Eye Y
Spot Healing Brush J
Healing Brush J
Content-Aware Move Q
Brush B
Color Replacement B
Clone Stamp S
Pattern Stamp S
Eraser E
Background Eraser E
Magic Eraser E



Gradient G
Paint Bucket K
Blur R
Sharpen R
Smudge R
Dodge O
Burn O
Sponge O
Horizontal Type T
Vertical Type T
Horizontal Type Mask T
Vertical Type Mask T
Rectangle U
Rounded Rectangle U
Ellipse U
Polygon U
Line U
Custom Shape U
Path Selection (=Shape Selection) A
Pencil N
Default Foreground/Background Colors D
Switch Foreground/Background Colors X
Toggle Preserve Transparency /
Decrease Brush Size [
Increase Brush Size ]
Decrease Brush Hardness {
Increase Brush Hardness }
Previous Brush ,
Next Brush .
First Brush <
Last Brush >



 "Utilities" Category

The "Utilities" category includes miscellaneous tools not fitting in the other sections of the E+ catalog.

 

       Apply Image

"Apply Image" tool is intended for blending, composite images, layers, or channels.
             For instance, the shells from the photo 1 can be transferred to the sand of the photo 2.

 

1. Open source and target images in PSE and make sure they have exactly the same pixel dimensions.

2. Select the target document.

3. (Optionally) duplicate the Background layer [Ctrl+J].

4. Run the "Apply Image"  script.

5. In the dialog that opens, choose the source document (fig. 3) and click "Next".

6. Now "Apply Image" dialog opens. If the source image is layered, you may specify layer in the "Source" menu 
(by default, it suggest "Merged" layer).

7. In the "Blending" menu, choose a suitable blending mode (on the screenshot 4, "Vivid Light" is selected).

 

 

 

 



 

8. If necessary, adjust the "Opacity" and other settings.

NB. If you happened to work with "Apply Image" dialog in the full Photoshop, you may notice that the PSE version 
is a bit messed up.  In  particular, the "Source"  (image)  drop -menu displays  the document  layers,  whereas 
the "Layer"  menu contains the color channels. Hopefully, this confusion doesn't prevent you from using the tool.
 

So, the source image has been applied to the current layer of the target document (fig. 5).

9. If you need to remove the effect from certain areas, create a layer mask and paint over the corresponding 
fragments with black color (fig. 6).

 



Color Mixer

The "Color Mixer" script's dialog is a replacement for the
missing "Color" palette.  In  other words,  it's intended  for  fine-
tuning the color you paint or fill with.

1. In the "Color" menu, select either Foreground or Background
color.

2. In the "Model" menu, chose a color presentation method:

RGB (Red-Green-Blue)
HSB (Hue-Saturation-Brightness)
CMYK (Cyan-Magenta-Yellow-Black)
Lab (Lightness-Red/Green-Blue/Yellow)

3. Adjust the  color with  the  sliders.  The changes are immediately
reflected in the Toolbox.

The meaning  of each slider  depends  on  the currently selected
color model.

In the example shown in screenshot, the CMYK option enables
cyan (C),  magenta  (M),  yellow  (Y),  and  black  (K) sliders.
Increasing "K" value means adding to  the  foreground color some black paint.

Convert to 16-Bit

This script creates a 16-bit copy of the current image.

On the screenshot,  the source 8-bit document
"DSC_6343.jpg" has been converted to 16-bit "DSC_6343 (16-
Bit copy)".

Honestly, since PSE provides very limited support for 16-bit
editing, the usefulness of such a conversion is questionable.

But at least, you have this option now.

 



Disk Label

 
This script prepares an image for printing on a

CD/DVD.

After applying the script you can readjust the composition by
moving or resizing the "Layer 1" smart object.

Easy Boxshot

The "Easy Boxshot" turns an image into a
product box.

Before using the script, you may want to alter the
image proportions with the Crop tool.

After applying the script, adjust, if necessary, the
perspective, add a backdrop image, etc..

 



Easy Clipping Mask

 

This utility  creates  a clipping mask from  the  current 
layer (serving as a mask) and the rest of composite image.

1. In the Layers palette, select the "masking"
(e.g., "shape" or "type") layer, as it's shown on the screenshot 1.

2. Open the "Scripts" dialog.

3. Run the "Easy Clipping Mask" script.

4. If necessary,  adjust  the  position  of  the  "Mask"  
and "Image" layers.

Edit in ACR

As we know, the Adobe Camera RAW includes some tools not
available in the Editor environment.

And how  about  adjusting,  for  example,  "Clarity"  or "Vibrance"
during extensive image editing in PSE?

The "Edit  in  ACR"  script  lets  you,  at  any  time,  open  the edited
document in ACR window (the image format doesn't matter).

Once ready  with  your  ACR  corrections,  click  the  "Open Image"
button. The  result  appears  in  the  source  document  as a separate
layer.

If needed, you may fade the achieved effect by reducing the "ACR"
layer opacity.

Let's make it clear that, when applied to a multi-layer document, the
script loads to ACR the composite (merged) image. To exclude some
layers, just hide them prior to starting the script.



Fade

This script lets you reduce effect of one or more recent steps.

1. In the History panel, select a desired document state (fig. 1). 
If you don't choose a history state the script will fade the very last step.

2. From  the Actions* panel,  open  the  Scripts  dialog  (fig.  2)  and run
"Fade"  script.

*Attention: the "Fade" script won't work if started from the Effects
panel.

3. In the  Layers  panel,  set  the  "history fading" amount by adjusting the
opacity of the "After" layer (fig. 4).

In the  example  shown in the  screenshots, we fade the  sharpening effect
as follows:
- In  the  History  panel,  we  select  "Levels"  state  (fig.  1)  -- because it
precedes "FS-Sharpener" step.
- We run "Fade" script.
- We  reduce  the  opacity  of  "After"  layer  (fig.  4)  to  reveal "not-yet-
sharpened" state.



Guide Layouts

This tool lets you create, save, and reuse custom guide
layouts (design markups).

1. Run the "Guide Layouts" script that opens the "New Guide
Layout" dialog.

2. Enter the desired sizes in the "Columns", the "Rows", and/or
the "Margins" fields (fig. 2).

3. To save the created layout for later use, pull down the "Preset"
menu and select the "Save Preset" option (fig. 3).

4. To apply a previously saved guide layout, choose its name in
the "Preset" menu (fig. 4).

The "Guide Layouts" tool comes to you with a few ready-made
preset layouts:
- "Find Center" adds horizontal and vertical guides at the
document center,
- "Golden Ratio" divides your image according to the divine
section rule,
- "Rule of Thirds" is a bit simplified version of the previous
algorithm.



Hide Luminosity

The "Hide Luminosity" script masks the image areas in
proportion to their lightness. This lets you, for example, to
instantly extract line art from a scanned drawing.

In case the current layer is not the "Background", after the launch,
the script asks you to specify what to mask - only current layer or
all layers (fig. 1).

On the screenshot 2, you can see the result of masking "all layers"
(that is the composite image).

To swap masked and revealed areas, just invert the mask color
(fig. 3) by pressing [Ctrl+I] keys.



History Brush

This script lets you paint over the image with one of its previous
history states. Thus, you can undo or fade changes within a specific
image area.

1. In the History panel, select a state you wish to paint with (fig. 1). If
you don't choose a history step the script uses the initial document state.

2. From the Actions* panel (fig. 2), open the E+ "Scripts" dialog and run
"History Brush"  script (fig. 3).

*Attention: the "History Brush" script won't work if started from the
Effects panel.

The script saves the selected history state as a separate layer, creates
"black" mask, activates the Brush tool, and chooses white foreground
color. Now you only have to adjust the brush diameter and other brush
tip settings.

3. Paint over the mask with white color to reveal the older history state
(fig. 4).

In the example shown in the screenshots, we remove "Adjust Sharpness"
effect from the flower as follows:
- In the History panel, we select "Adjust Hue/Saturation" state (fig. 1) --
because it precedes "Adjust Sharpness" step.
- We run the "History Brush" script.
- We paint over the flower (fig. 4) to reveal "not-yet-sharpened" state.

 



Layer Comps

By merely manipulating layers in a document, you can
achieve utterly different results. The layer comps let you save
multiple designs within a single PSD file.

1. Open a layered document or create a new one.

2. Run "Layer comps"  script.

3. In the "Layer Comps" dialog box, click the "New Layer
Comp" button (fig. 1).

4. In the "New Layer Comp" dialog, specify which parameters
should be saved to the new composition (fig. 2). The
"Visibility" option means the layer opacity value; the
"Appearance" is responsible for its style and blending mode.

5. Make some changes to your layers - hide, move, add layer
effects, or change blending modes. Then create a new 

layer comp.

6. Now that you have several comps, you can easily switch
between them. Just select the required item in the "Layer
Comps" dialog and click  "Apply" button (fig. 3).

7. To alter a created comp, modify your layers as needed, then
open the "Layer Comps" dialog, select the required comp, and
click "Update"  button.

8. If you need to save all the created layer comps as individual
images, open the "Layer Comps" dialog and click "Layer
Comps to Files"  button.



Meta Stamp

The "Meta Stamp" script creates on the image a kind of "boilerplate" containing the file name, EXIF tags, 
and other metadata.

1. If you want the stamp to include document title, author name, or
copyright notice, open the "File Info" dialog (File > File Info) and fill the
appropriate fields.

2. From the "Scripts" dialog, run the "Meta Stamp" script.

3. In the dialog box that appears, check the boxes next to the data that
should be included in the stamp.

In the "More Options" area, define all the other stamp settings:

4. In the "Font" line, choose font family, size, and color.

5. In the "Position" menu select the image corner where the stamp will
appear.

6. The "Drop Shadow" option adds to the stamp layer the "Shadow"
effect.

7.  To merge the stamped image into Background layer, check the
"Flatten" checkbox. Unchecking this box means leaving the stamp in
separate text layer.

8. To stamp all the currently opened documents, check the "Stamp all
open images" gadgets. Of course, for each document the script uses its
own metadata.

9. Click the "Run" button to apply the stamp.

To stamp an entire folder of photographs, you use the "Batch" dialog:

1. Open any image having all the required metadata. That is, if you want
to include the EXIF tags, it should be a file from digital camera; if the
stamps must contain the author name, open the "File Info" dialog and
fill the necessary fields (see above).

2. Call the "Meta Stamp" dialog and make your choices.

3. Click the "Save and close"  button to remember the settings.

4. Open the "Batch" dialog.

5.  Select for execution the "Meta Stamp -batch edition" script.

6. Choose the "Source" and "Destination" options.

7. Click "Run" to start the batch processing.



Share Pixels

This script copies the selected area of a document to exactly the same place in another document.

Thus, we can, for example, add an inscription to a 16-bit photo without converting it to 8-bit mode.

1. Duplicate the original 16-bit image (File > Duplicate) and convert the copy to 8-bit mode 
(Image > Mode > 8 Bits/Channel).

Now you have the original 16-bit document (on the screenshot - "DSC_3833.NEF") and its 8-bit copy 
("DSC_3833 copy").

2.  In the 8-bit document, create a text layer, apply to it some effect or a filter if needed.

3. Select the inscription with a selecting tool.

4. Run "Share Pixels"  script and the text appears on the 16-bit image.



Vectorizer

This script makes a vector shape layer based on the composite
image contents.

1. Open any image.

2. By default, the script selects on the picture the darker areas. To
use the lighter areas, just invert the image color (fig. 1) by pressing
[Ctrl+I] keys.

3. Run the "Vectorizer" script.

4. In the dialog box that opens, play with the "Threshold" slider to
achieve the best black-to-white ratio (fig. 2). Now the darker areas of
your image are selected (fig. 3).

5. There appears the "Refine Edge" dialog. If necessary, smooth the
jagged edges to round the outlines of the created path (fig. 3).

6. Now that selection is converted to a vector path, the script asks
you, if you want to create from it a shape layer (fig. 4).

7. If you click "No", the outline stays in the document just as Work
Path and you can find it in the "Paths" dialog.

8. If you click "Yes", a new shape layer appears in the Layers palette.
To change its color call the Color Picker by double-clicking on the
"Color Fill" layer thumbnail.



Watermarker

The "Watermarker" script creates a "carved" watermark from
a "logo" file on your computer.

1. Prepare a layered document that will define the logo shape and
save it as on your computer (sample logo is available here).

2. Open the "Scripts" dialog and run the "Watermarker" script.

3. In the dialog box that opens, browse to the saved "logo" file and
click "OK".

4. The logo appears in the bottom right corner of the document.
Press [Ctrl+T] and adjust the new layer size and position.

5. If necessary, double click the "fx" icon on the "logo" layer and
alter the effect settings.

To watermark multiple images, you use the "Batch" tool:

1. Open any image.

2. Run the "Watermarker" script, choose a "logo" file and click "OK".
This makes the script to remember the logo source file location.

3. Call the "Batch" dialog.

4.  Choose for execution the "Watermarker -batch edition" script.

5. Choose the source directory and "Destination" options.

6. Click the "Run" button to start the batch processing. 



"Slices" Category

 

 

This set of scripts lets you create and save
Web-pages.



About Slicing

As we know, Photoshop Elements has a lot of hidden talents. Turning images into interactive webpages is one of
those.

Broadly speaking, the conversion workflow looks like this:

1. Dividing the image to functional pieces: the album header (slice #03), top navigation bar (slices #05-08), the
main photo (slice #13), photo previews (slices #11, 15, 17, 19), etc..

2. Assigning a URL (Internet address) to each navigation element. For instance, the slice #05 (Home) should be
linked to the site's main page, while the slice #23 (Next) must lead to the follow-up album page.

3. Optimizing the page, that is defining graphic formats and other setting. Every slice may be optimized
individually. For example, the main photo (slice #13) may be saved as high quality JPEG, whereas the
background slices (#01, 02, 04, 10, etc.) may be exported as low quality GIFs. Such an approach allows to
reduce the page total size and download time, respectively.

4. Exporting the document as HTML file and a set of images.

Eventually, you get a real webpage with working hyperlinks.



How to Slice in PSE 15+

Since PSE 15 and newer versions don't include the Slice  tool, we can only create slices from either guides or
selections.

1. To slice the entire image at once, markup it with the guides, as shown on the screenshot 1. Then open the "Scripts"
dialog and run  "Slices from Guides" script.

2. To create a single slice, select the area of interest with the Rectangular Marquee  tool* and then run  "Slice from
Selection" script (fig. 2). 
*In case of a separate layer, just [Ctrl]-click its thumbnail in the Layers panel (fig. 2/2).



The slices created by you are "user-slices" (their number-pictograms are blue). To generate HTML-table covering the
whole document, the app may also create additional cells called "auto-slices" (with gray pictograms).

PSE tends to hide the auto-slices. However, you can see them anytime in "Save for Web" dialog.

Tip. If you can't see the slice pictograms, run  "Show Slice Numbers" script.



How to Slice in PSE 6-14

In PSE 6 through PSE 14, the Slice  tool is hidden in the Toolbox under the Crop  button. 
However, activating it requires a tiny workaround.

1. If you haven't loaded the extended keyboard shortcut set yet, run the Shortcuts+ script now.

2. Press [C] key twice, and voila -- the "Slice"  icon appears in the Toolbox.

3. Drag a rectangle over a specific image area, for example, the album header.

This creates a user-slice (pictogram in its upper left corner is blue). To generate a table filling the whole document,
Photoshop Elements adds several cells called auto-slices (their pictograms are gray)*.

*If you can't see the slice pictograms, open the Scripts dialog and run the  "(Show Slice Numbers" script.

 

4. While the created slice is selected, it has a bounding box with transform controls. You can move or resize it with the
Slice  tool -- the rest of the table rebuilds automatically.

5. Cut out the rest of the page elements: the current photo, previews, text links.

Tip. While slicing your document, aim at keeping the table structure as simple as possible. That is, avoid overlapping
and intermediate slices. Draw the new slices right from the border of the existing ones.

6. Press [C] key once again. The Slice Select  tool's icon appears in the Toolbox. This auxiliary instrument will help you
to edit the created slices.

7. Click one of the slices to select it. Then hold [Shift] key and select several more slices. Now you can align the selected
slices by clicking the proper button on the Tool Options panel.

8. To use the created slices later on, save the document as PSD file.
In case the slices aren't visible in the re-opened PSD, just activate the Slice  tool.



Editing Slices

Now that the image is sliced, you may need to modify some of the slices.

1. To choose (activate) a specific slice, make a selection inside its borders with the  Rectangular Marquee tool as shown
on figure 1/1 (the selection corners shouldn't touch the slice boundaries). Then run  "Select Marked Slices" script (fig.
1/3).

To select an additional slice (for example, to add slice #52 to already active slice #32), mark it with the  Rectangular
Marquee tool (fig. 1/1) and then hold down [Shift] key while running the  "Select Marked Slices" script (fig. 1/3).

To select several adjacent slices at once, mark the whole range with the  Rectangular Marquee (on fig. 1/2: slices #32,
#42, and #52), and run  "Select Marked Slices" script (fig. 1/3).

NB. Using the  "Select Marked Slices" script isn't always necessary. In most cases, you can just mark the needed

slice(s) with the  Rectangular Marquee tool and then run  "Delete",  "Combine",  "Divide",  "Promote",

or  "Slice Options" script.

2. To assign a hyperlink to the selected slice, run  "Slice Options" script and, in the dialog that opens, type the
desired address into "URL" field (fig. 2).



3. To reposition or resize the selected slice, open  "Slice Options" dialog and edit the corresponding fields in the
"Dimensions" area (fig. 3).

4. To align the created slices to each other, select 2 or more slices, run  "Align Selected Slices" script, and select an
option in the dialog that opens (fig. 4).

Tip. To keep the HTML-table structure simpler, it is recommended to avoid overlapping and unnecessary slices.

5. To remove unnecessary elements, select  one or more slices and run  "Delete Selected Slices" script (fig. 5).
(Keep in mind, though, that any empty space is automatically filled with the auto-slices.)



6. For joining several adjacent slices, select  them and then run  "Combine Slices" script (fig. 6).

 

7. If you need to convert an "auto-slice" to "user-slice", mark it with the  Rectangular Marquee tool and run 
"Promote to User Slice" script (fig. 7).

8. To re-use the created slices later on, save the document as PSD file.
In case the slices aren't visible in the re-opened PSD, select  a small portion of the image, open  "Slice Options"
dialog, and click "OK".



Saving Web Pages

1. Open the "Scripts" dialog and run  "Export Slices" script.

In the "Save for Web" dialog that opens, you can define optimization settings for each slice individually.

2. Click on a slice and then choose an output format and other options.

3. To edit multiple slices at once, hold down [Shift] key while selecting them.

4. Note that all the "auto" (gray) slices are linked to each other. That is by editing one of those you modify all the other
auto-slices as well.

In the example shown on the screenshot, the "main photo" slice is set to 75% JPEG, "previews" -- to 60% JPEG, "text
navigation" slices -- to 32-colors GIF, and the auto-slices -- to 8-colors GIF.

5. Click "Save" and -- in the next dialog -- choose the target folder for the slices.

The HTML file get saved into the specified folder as "<source-image-name>.html".
The graphic files (slices) can be found in the "images" subfolder.



"Data-driven Graphics" Category

These scripts help you to automate creation of template-based images.

 

Defining Variables

Suppose, while developing an app for tourists we need to create a
greeting card for each destination offered. Furthermore, the greeting
message should be localized (that is, its text should depend on the
user language).

Assuming there are 30 destinations and 20 user languages, we have
to prepare 600 similar pictures. Surely, we'd like to somehow
automate the workflow .

1. We begin with creating a template document containing all the
required elements. In the example on the screenshot, the graphics on
the "Photo"* layer depicts one of the offered destinations, while the
text of the "Welcome" layer depends on the localization language.
Now we have to explain this to PSE.

*Defining a variable for the Background layer isn't possible.

2. Launch the Define Variables  script.

3. In "Variables" dialog window, select "Photo" layer.

4. In "Variable Type" area, check "Pixel Replacement" gadget. In "Name" field, enter some meaningful 
name,  for example, "welcome_image".

Now we can change the displayed photo by modifying the "welcome_image" variable.

5. Select the "Welcome" layer and check "Text Replacement" as variable type. Let's name the new 
variable "welcome_header". From now on, the contents of the text layer depends on this variable's value.

 



Creating Data Sets

Now we have to tell Photoshop Elements all the possible combinations of destination photos and welcome messages.

1. Start the Define Variables script.

2. In the uppermost menu of the "Variables" dialog, select the "Data Sets" item.

3. In the "Data Set" row, click "New Data Set"  button. In the text field, enter a meaningful name for the first
"destination_localization" pair. In the below example, "Thailand_DE" means a journey to Thailand for German
speaking tourists.

4. In "Variables" area, choose "welcome_header" name. Then enter the message text into "Value" field.

 

5. Now select "welcome_image" variable, click "Select File" button, and browse to the image file depicting the current
destination.

6. Create a new data set  and define for it a combination of the destination photo and welcome text. 
And so on...



   Importing Data Sets
 
 
 
 
Creating data sets in the "Variables" dialog is a simple but not very efficient method. 
 
If you need a large number of data sets you'd better compose a list of those with an external text editor and then 

import the list into Photoshop Elements.

To hold names of the imported sets we may need an extra variable.

1. Create in the document a new text layer (with whatever content) and hide it. Let's name this layer "hidden text".

2. Open  the "Variables" dialog, select "hidden text" layer, set variable type to "Text Replacement", and name 
the new variable "country_language".

This variable will help us to identify the imported combinations of destination and localization.

3. Now open any text editing app, create a new document, and enter a text like this:

country_language, welcome_header, welcome_image

kenya_en, Welcome!, c:\My Project\Welcome Photos\Kenya.jpg
kenya_de, Willkommen!,c:\My Project\Welcome Photos\Kenya.jpg
kenya_ru, Добро пожаловать!,c:\My Project\Welcome Photos\Kenya.jpg
kenya_jp, ようこそ!,c:\My Project\Welcome Photos\Kenya.jpg

thailand_en, Welcome!, c:\My Project\Welcome Photos\Thailand.jpg
thailand_de, Willkommen!,c:\My Project\Welcome Photos\Thailand.jpg
thailand_ru, Добро пожаловать!,c:\My Project\Welcome Photos\Thailand.jpg
thailand_jp, ようこそ!,c:\My Project\Welcome Photos\Thailand.jpg
...

The first line contains comma separated variable names, exactly the same as in the "Variables" dialog.
(A mismatch of variables quantity or any error in a name will result in import failure.)

Each of the below lines contains a set of the variable values:
destination_localization, welcome message, path to the graphic file.

4. Once the list of data sets is ready, save it as a plain text (.txt) document.
In case the document contains non- Latin characters,be sure to choose the proper encoding, e.g., UTF-8.

5. Return to PSE Editor and run "Import Data Sets"  script.
In the dialog that opens, browse to the file saved in p. 4.

6. In the next dialog, make sure that:
- The proper encoding is selected (the "Automatic" option may not work).
- "Use First Column For Data Set Names" gadget is checked. (That's what "country_language" variable was created for.)
- "Replace Existing Data Sets" option is selected.

7. Press "OK" and -- if everything has been done correctly -- the imported data sets appear in your document.

 Now you can find them in the "Variables" dialog. 



Applying Data Sets

So, we have imported / created lots of data sets. What good it makes?

1. Launch "Apply Data Set"  script. The dialog that opens displays the list of
all available data sets.

2. Check "Preview" option. Now you can switch between data sets without
closing the dialog window.

3. If you want to load one of the sets into the source document, click "Apply"
button.

4. To save all the design versions at once, run "Export Data Sets as Files" 
script.

5. In the dialog that opens, select the target folder and file naming rules.
In the screenshot, the files should be named after the source data set.

On clicking "OK", PSE saves the generated images into the specified folder as
PSD files. For quick conversion of these files to a Web-friendly format, consider
the "Batch" tool.



Handling Scripts

Now let's see how to manage scripts in the E+ catalog. To add a new script, choose the target category in the drop 
menu, then press the "Add"  button, and, in the dialog box that opens, find on your computer the wanted JSX file.

To read a script info (fig. 1) select it in the list and click the "Info" 
 button. (In case the script's info is unavailable, the  button is

disabled.)

To add to the "Favorites" (default) category a script from another
category, select it in the list and click the "Favorites"  button.

To add a script to the Effects panel, use the  button.

To rename a script use the "Rename"  button.

To delete a script, click the "trash"  button.

To make in the E+ catalog a new category, click the "Add/remove
category"  button and enter desired name.

To remove a category, select it in the drop menu, delete all the scripts
and click the "Add/remove category" button. Removing non-

empty categories is not supported.

Alternatively, you may manage the scripts with any file manager. The
E+ catalog is located on your computer at the "C: > Elements+ > 15.0
> Scripts" directory (fig. 2).

To add a new category with a certain name, you create in the "Scripts"
folder an accordingly named subfolder.

To add new scripts into a certain category, you copy the
corresponding JS or JSX files into the appropriate subfolder of the
"Scripts" directory.

To add a script into the "Favorites" category, copy its file into the
catalog root directory (that is, into the "Scripts" folder).

To save user-defined options and dialog locations, each script creates
its own INI file in the "C: > Elements+ > 15.0 > Required > ini"
folder. In same cases, the INI data writing error may result in the
script's unworkability. To solve this problem, just delete the
corresponding INI file. For example, if the "Meta Stamp" dialog won't
open, go to the "ini" folder and delete the "Meta Stamp.ini" file.

 
 
 

Alternatively, you can reset all the E+ dialogs as follows:

1. Run the "E+ Options" script.

2. In the dialog box that opens, click the "Total reset"  button. This deletes all the files in your "ini" folder at once.

 



Generating Scripts

Additionally, the  "Batch"  tool  lets  you  create  custom  scripts by
concatenating the existing ones.

For the  purpose,  you  may  use  absolutely  all  the  scripts  from the
"Commands" and "Batch  Optimized" categories,  and most  other tools
from the E+ catalog.

1. To begin  with,  add   all  the  required  scripts  to  the  "Batch

Optimized" folder.  For  example,  on  the  screenshot,  the  "adjust -
Black&White Layer"  command  has  been  borrowed  from  the
"Commands" category.

2. Open the "Scripts" dialog and launch the "Batch" script.

3. From the "Scripts to Run" drop  menus, select  scripts  in desired
execution sequence.

4. Click the "Save Sequence" button.

5. In the dialog box that opens, enter the new script name and click
"Save".

The generated scripts appear in the "Batch Optimized" category 
("C: > Elements+ > 15.0 > Scripts > Batch Optimized" folder).

Getting More Scripts for PSE

On the  Internet,  you  can  find  lots  of  (mostly  free)  scripts  for  the  full  Photoshop.  Although many of those aren't
compatible with PSE, you can find some workable and useful tools by using trial and error method.

Adobe Exchange  is  one of  the  main  resources  for  the ready  made  scripts.  And  many  more  can be found via some
googling.

In some cases, you can create a custom script for a special task by using the "Batch" dialog. However, to automate most
of your tasks, you may want to compose JavaScript scenarios with your own hand.

The official (although not thorough), documentation on this subject is available at the Photoshop Developer Center.

Also, there are some informal PS scripting communities, and the PS-Scripts.com forum is, probably, the most competent
and useful of those.

On this resource, you can find both the answers to you questions and pieces of code generously shared by the skilled
coders.

 



RAW Corrections

This dialog  includes  several features,  otherwise  unavailable in  the PSE -version of  the  Adobe 
Camera RAW plug-in (hereinafter, "ACR"). It allows to edit both RAW and regular graphic files.

Notwithstanding the format of the edited image, all the changes are stored in a sidecar XMP file.

1. To choose a tab (feature set) click the corresponding button at
the dialog top (fig. 1).

2. By default,  the  preview  image (fig.  2/1) is  updated  after each
editing step.  In case  these  updates  significantly  slow down your
work, choose a smaller preview size in the drop menu (fig. 2/2).
The size change will take effect on the next dialog opening.

3. In case  after completing  the  "undocumented"  corrections you
decide to continue editing your image in the native ACR plug-in
window, check "Show ACR" gadget (fig. 3).

4. To  confirm  the  changes  and  open  the  picture,  click "OK"
button (fig. 4).

5. For  8 -Bit images,  the  edited  image  appears  in  the same
document as  a  new layer. Thus,  you can  evaluate the  correction
result by turning the uppermost layer on and off (fig. 5).

When working in  16 -bit mode,  the  edited  photo  opens  as  a
separate document.

Important! The script works correctly if the ACR plug-in saves
the image settings to sidecar XMP files. Although this option
must be selected by default, it's recommended to check the ACR
plug-in preferences by clicking the  button in the ACR
window.



"Basic" Tab

This tab mostly duplicates the basic features of the

ACR dialog in PSE.

In addition, it includes two missing controls.

1. "Texture" slider* lets you accentuate or smoothen image
details (fig. 1).

2. "Dehaze" slider* is intended for reducing or increasing
haze in a photo (fig. 2).

*Available in PSE 2019 and above.



Graduated Filter

Graduated Filter feature lets you apply tonal and color

corrections gradually.

1. To create a filter, click "+New" button (fig. 1).

By default, a new filter darkens the upper part of the edited image, thus
mimicking a real-life photo filter. However, its range and effect are
broadly adjustable.

2. To modify the way the effect grows across the picture, select "Mask"
sub-tab (fig. 2).

This invokes some visual aids over the preview. The small red dot (fig.
2/1) marks the gradient beginning; i.e., the zero-effect area. The big
green dot (fig. 2/2) means the gradient end (the full effect zone).

3. To quickly change the gradient direction, click one of the "preset
mask" buttons (fig. 3).

4. To customize the gradient, move its "start" and "end" points with
the corresponding sliders: "Zero Effect" panel (fig. 4/1) is responsible
for the red dot, "Full Effect" sliders (fig.4/2) control the green one.

5. To modify the effect itself, go to "Adjustments" sub-tab (fig. 5) and
move the sliders.

6. A single photo may have multiple graduated filters applied to it, with
different effects and in different directions. For example, on the bellow
screenshot the additional filter (fig. 6/1) increases contrast for the right
edge of the image.

While the "Mask" tab is open, the currently edited filter is shown in red
and green (fig. 6/1), whereas all the other filters are white (fig. 6/2).

To modify a non-selected ("white") filter, choose it in "Filter #" menu
(fig. 6/3), and then adjust its effect or direction / mask.

To disable unnecessary filter, select it (fig. 6/3) and then hide it 
(fig. 6/4) or delete it  (fig. 6/5).



Tone Curve

"Tone Curve" feature offers the same possibilities as

the Curves tool, however its settings are stored in sidecar
XMP files. So, it may be useful, i.e., for "non-destructive"
corrections of 16-Bit photos.

1. For a quick tonal correction, choose a suitable preset in
"Curve" menu (fig. 1).

2. To modify the curve manually, click "Edit" button (fig. 2)
and make the required changes in the "Curves" dialog that
opens (fig. 2/1).

3. In case later on, you decide to reshape the curve, open 

"RAW Corrections" dialog, go to  "Tone Curve" tab, and

click "Edit" button (fig. 2).

 



Color Mixer

The "Color Mixer" tab can be used for color correction and

BW conversion.

1. For color adjustment, select a tab corresponding to the required
color property - Hue, Saturation, or Luminance (fig. 1).

Then, tune the selected parameter with the "color range" sliders.

For instance, in the screenshot 1, luminance of "Blues" and "Aquas"
is reduced, while luminance of "Reds" and "Oranges" is increased.

2. To make a color image black and white, check "Convert to BW"
option (fig. 2) and specify with the sliders how the original colors
influence the resulting monochrome image.

The screenshot 2 exemplifies darkening the (formerly) blue sky and
lightening the orange rock.



Optics

 This  tab  is  intended  for  removal of  lens-specific chromatic 

aberration and vignetting.

1. To enable the automatic removal  of red-green and blue-yellow
color shifts (lateral chromatic aberration), check "Remove Chromatic
Aberration" gadget (fig. 1).

2. For removal of purple/green fringes (axial chromatic aberration)
set the color suppression strength with "Purple amount" (fig. 2/1) or
"Green Amount" slider (fig. 2/2).

3. If  necessary, use "Purple Hue"  (fig. 3/1) and  "Green  Hue" (fig.
3/2) sliders to extend or narrow the tool's color range.

4. To reduce vignetting (lens edge darkening), brighten the corners
with "Amount" slider (fig. 4/1).

To adjust the tool's range, use "Midpoint" slider (fig. 4/2).

Color Grading

The "Color Grading" tab is meant for coloring

grayscale images.

1. For example, increase saturation and choose color
hue for the midtone areas (fig. 1).

2. Increase saturation and choose color hue for the
highlights (fig. 2).

3. Set saturation and hue for the shadows (fig. 3).

4. Adjust the influence of the tonal ranges with the
"Blending" and "Balance" sliders (fig. 4).



Geometry

This tab allows to correct geometric distortions.

1. To  enable  the  automatic  correction  of  lens-specific
distortions, check "Enable Profile Corrections" gadget. (fig. 1).

2. For manual corrections, use the sliders as shown on the fig. 2.

 

Effects

This tab includes "Grain" and "Post Crop

Vignetting" effects.

1. The "Grain" controls let you imitate grainy film (fig. 1).

2. The "Post Crop Vignetting" feature creates a frame-like
effect by darkening the image edges (fig. 2).



Camera Calibration

 "Camera Calibration" tab allows to define how the ACR plug-

in renders the color from your camera.

1. For example, if the darker areas of your photo are greenish, pull
"Shadows" slider to the right (fig. 1).

2. Or, if the red color is much too vivid, adjust it with "Primary Blue"
sliders (fig. 2).

3. If you want to apply the same calibration settings to all the photos
from your camera:
- open a RAW file in PSE with the default settings (without any
correction);
- open raw  "RAW Corrections" dialog and accomplish the 

camera calibration;
- open the same photo in "Adobe Camera RAW" plug-in window;
- in the plug-in menu, select "Save New Camera Raw Defaults" option.

Presets

"Presets" lets you save and reuse the correction settings.

1. To save the current settings as a preset, click "Save" button (fig. 1/1),
in the dialog that opens, enter the new preset name (fig. 1/2), and press
"OK".

2. To apply the saved settings to another photo, open it in PSE, call
"RAW Corrections"  dialog, go to "Presets" tab, and double-click the
required preset (fig. 2).

3. "Ignore Basic Corrections" option (fig. 3) defines weather a loaded
preset should overwrite the current "Exposure", "Contrast", and other
settings on the "Basic"  tab.



Tool Presets

As we  know,  the  Tool  Options  panel  allows  to
dramatically change a tool's behavior. For quick
switching between  various  usage  scenarios,
consider "Tool Presets" feature.

0. Choose a tool in the Toolbox and customize its
settings in the Tool Options panel (fig. 0).

1. Open "Tool Presets" dialog and click "Create" button 
(fig. 1).

2. In  "Create  Preset" dialog that  opens,  enter  a descriptive
name (fig. 2) and click "OK".

The savable settings for the current tool are specified in the
"Options" section (fig. 2/1).

Not all parameters  can  be stored  to  a  preset. For  example, in
certain cases,  brush  tip  shape,  scatter,  and  some  other
settings may not be saved.

In the  meantime,  for  the  Crop   Tool,  you can  define "Hide
cropped pixels" option (fig. 2/2), which is unavailable in the
Tool Options panel.

3. To load the saved settings, open "Tool Presets" dialog and
double-click the required item (fig. 3).

4. By default, the dialog only displays presets for the currently
selected tool. If you want to switch between any tool presets,
uncheck "Current Tool Only" gadget (fig. 4).



About Frame Animation

By default, PSE suggests animating graphics in two stages:
1. Preparing a separate layer for each planned frame. 
2. Setting animated GIF's options in the "Save for Web"
window.

Elements+ offers a more robust and flexible approach based on the
Photoshop "frame animation" technique.

To alter the composite image appearance for a specific frame, we edit
the existing layers' properties:
- position (but not the size!)
- visibility (including partial opacity change)
- style (effects and blending options).

In short, the workflow looks like this:
- create as many frames as needed;
- modify layer properties for each frame;
- set delay time for each frame;
- export the created animation as GIF file;
- save the source document as PSD file.

This approach lets us compose more complex animations by using fewer layers. 
For example, the GIF image on this page was created with just two layers.



Animation Dialog

To open the "Animation" dialog, you either play "Animation" action from Elements+ action set or run "File >
Automation Tools > e+ Animation" command.
*Opening this dialog from the Effects panel is possible but not recommended because this method doesn't work for
hidden layers.

1. To view/edit a specific frame, select it in the "Frames" list (fig. 1).

To modify multiple frames at once, hold down [Shift] or [Ctrl] modifier key while selecting.

To create a new frame, run  "Duplicate Frame(s)" command in the "Commands" list (fig. 3).

2. The "Layers" list (fig. 2) lets you select, hide/show, and fade layers without closing the "Animation" dialog.

To show or hide a layer for the selected frame(s), choose it in the list and then double-click either  "Show Layer" or 
"Hide Layer" command in the "Commands" list (fig. 3). Alternatively, you can turn visibility on/off by double-clicking a
layer in the "Layers" list (fig. 2).

3. To change the duration of the selected frame(s), use  "Set Frame Delay" command in the "Commands" list (fig. 3).
Alternatively, you can open "Frame Delay" dialog by double-clicking a frame in the "Frames" list (fig. 1).



4. By default, a new animation is set to play only once. To change this setting use "Loop" menu (fig. 4).

5. Once a frame (or multiple frames) chosen in the "Frames" list, you can close the "Animation" dialog and edit the
selected frame(s) in the PSE environment:
- So, click "OK" button (fig. 5). 
- Choose some layer(s) in PSE "Layers" panel (fig. 7). 
- Adjust the layer position with the  Move tool (fig. 8).
- Hide/show layers, reduce opacity, or change their blending modes in the Layers panel (fig 7).
- Use PSE "Styles" panel, "Style Picker", "Style Settings" dialog, or Elements+ "Styles" dialog to add/modify layer effects.

6. While the script dialog is open, PSE may not display the selected frame in the image window. The preview at the
dialog top (fig. 6) shows the current frame's appearance in real time.



Tweening

You don't always need to create and modify each frame manually. Some of the tasks can be done automatically.

For example, an object's movement or a shape's transformation can be animated like follows.

1. Create two frames containing the initial and final states.

This may be done
- by showing different layers for each frame
- or by repositioning the same layer(s)
(fig. 1/1 --> fig. 1/2).

2. In the "Frames" panel of the "Animation" dialog, select the both -- initial and final -- frames (fig. 2).

3. Run  "Tween" command (fig. 3).



4. In the dialog that opens, define how many frames should be inserted between the initial and final frames (fig. 4).

5. Optionally, you may also define which layer parameters should be "tweened": position, opacity, and/or effects 
(fig. 5).

PSE automatically inserts the intermediate frames and sets the layer properties for each one.



Interpolate Layer

Sometimes, you may want to alter the behavior of an animated object or to add a new object into an existing frame
sequence.

0. Decide on the initial and final frames of the planned event.

For example, let's make the creeping line appear in the Frame 9 and disappear in the Frame 21 (screenshot).

1. Select the "initial" frame and then set the "object" layer's position (fig. 1) and/or opacity.

2. Select the "final" frame and set the layer position (fig. 2) and/or opacity.

3. In the "Frames" list, select the "initial through final" frame range (fig. 3).

4. Make sure the "object" layer (or multiple layers) is selected in the "Layers" list (fig. 4).

5. Run  "Interpolate Layer" command (fig. 5).

The script automatically re-calculates the layer position and opacity for the intermediate frames.



Unifying Layer Properties

And what if you need to modify the appearance of the entire animation?

Solution 1: To apply the current layer properties to all the frames, run  "Match Layer across Frames" command
(fig. 1/1) and, in the dialog that opens, define which exactly properties to match (fig. 1/2).

Solution 2: Run  "Select All Frames" command (fig. 2) and then hide, show, move layers, or edit layer styles.

Solution 3: By default, modifying the first frame of the animation affects all the other frames as well. So, you can just
select the Frame 1 (fig. 3) and then make the required changes.

If you want to edit the first frame without altering the follow-up frames, uncheck "Propagate Frame 1" option (fig. 4).



Saving Animation

I. To optimize the quality of the created animation:

- In the "Animation" dialog, run  "GIF Options" command.
- In "Save for Web" dialog that opens, set the number of colors, transparency, matting, and/or other parameters
(fig. 1).
- Click "Done" button (fig. 2).

II. To preview the animation with your default Web browser:
- In the "Animation" dialog, run  "Preview in Browser" command.

III. To save the final animatied image:

- In the "Animation" dialog, run  "Export as GIF" command.
- In the "Save for Web" dialog that opens, click "Save" button (fig. 3).
- Specify the target folder.



Macros

In full Photoshop, actions are a great time
saver allowing users to record their repeating
tasks and replay those afterwards with a click.

Unfortunately, Photoshop Elements doesn't let you
create custom actions of your own. That's why you may
need "Macros" kit to streamline your workflow.

In short, you save (fig. 1) a chain of editing steps as a
macro, and then play it through the Scripts dialog (fig.
2).

Technically speaking, such an automatically recorded
sequence is a regular script. The term "macro" is used
here only to distinguish your own custom scripts from
all the others in E+ catalog.

Important! To enable the automatic recording you have
to download Scripting Listener plug-in and install it
into PSE.

To make sure the plug-in works, restart Photoshop
Elements, open any image, and then find a file named
"ScriptingListenerJS.log" on your Desktop. Thereafter,
you can proceed to the macro recording.



Macro Recording and Saving

So, you have installed "Scripting Listener" and made
sure it records your PSE activity.

Now open the Actions panel (Window > Actions), go to
the panel menu, choose "Load Actions" command,
browse to "C: > Elements+ > 15.0 > Actions", and load
"Macros.atn".

Then prepare all the prerequisites for your planned
macro. For example, open some file if the macro
should edit the current image; select some area if pre-
selection is required, and so on.

Now, at last, you are ready for the macro recording.

1. Choose  "New Macro" action and play it (fig. 1).

2. Accomplish the steps you want to record. For
example, duplicate layer, adjust "Brightness/Contrast",
apply a sharpening filter, crop the image (fig. 2), etc..

3. By default, the recorded macros execute silently (i.e.,
without user interaction). To make a command's
settings customizable on playback, run [.] "Dialog"
action right upon completing the corresponding step.
For instance, to allow altering cropped area:
- commit the cropping (fig. 2) 
- then play the [.] "Dialog" action (fig. 3).

4. Once all the necessary steps done, play  "Save
Macro" action. Then, in the dialog that opens, enter
the macro name and save it.

By default, your macros are saved to "My Macros"
subfolder of the E+ Scripts catalog. However, you may
choose any other location.



Pitfalls and Workarounds

Please, keep in mind that not any Photoshop Elements activity can
be recorded to a macro.

1. First off, any clicks in the "Effects" and "Graphics" panels are not
recordable.

Possible solutions: Instead of "filter" thumbnails, use the
corresponding commands in the "Filter" menu. To apply "drop
shadow" or some other layer style, create it with the "Style Settings"
command (Layer > Layer Style > Style Settings), as shown on the
screenshot. To record an action execution, load it into the Actions
panel.

2. Brush, Pencil, Sponge, Selection Brush and other "painting" tools
can't be recorded.

Possible solutions: For area selecting, use Marquee, Polygonal Lasso,
or Magic Wand tool. To imitate the Brush strokes, select some
fragment, then feather (Select > Feather), and fill it (Edit > Fill
Selection).

3. We can't record any commands and tools that are missing in full
Photoshop: "Smart Tone", "Smart Fix", "Auto Red Eye Fix", "Convert
to Black & White", Straighten Tool, and some others.

Possible solutions: Look for an alternative, Photoshop-compatible
approach. For example, "Auto Levels" and "Auto Color Correction"
work fine for automatic adjustments. For B&W conversions, use
"Desaturate" or "Gradient Map" command.

4. Separately, we note that, in some cases, "Image Size" command
may be recorded incorrectly. Therefore, for altering pixel
dimensions, consider "Fit Image" command (File > Automation
Tools > Fit Image).

In addition, it must be remembered that the edited images may
differ in size, aspect ratio, color depth, and other properties.

To create an "all-image" macro, we should opt for "all-mode"
algorithms, test the recorded macro thoroughly, and, if something
goes wrong, devise a workaround.



Auxiliary Commands

Let's see how to use the three auxiliary commands of
the "Macros" set.

1. To execute the last saved macro without opening the
"Scripts" dialog, just play  "Test" action.

2. In case, while recording a macro, you need to
perform some tasks that shouldn't be recorded, play 

 "Pause Recording" action. When you are ready to
continue, use  "Resume Recording" action.

3. If you have recorded a part of a macro and want to
validate it without saving, use  "Pause Recording"
and then  "Test" command. (In the "Pause" mode,
"Test" executes the current, yet unsaved recording).

In case the recording works fine, either  save it to
macro or  resume recording. If the recording
doesn't work as intended, start a new macro.

4. If you want to append a few steps to the last saved
macro, use "Resume Recording" action. When
finished,  re-save the macro.



About Alternative Elements+ Interface

In case the E+ scripts don't work on your computer properly,
if you find them slow or inconvenient, perhaps, the
"windowless" version of this patch interface would suite you
better.

As opposed to the standard "scripted" version, it's based
mainly on the "actions" (macros recorded in full Photoshop).

Since such an approach means an individual thumbnail for
every single action, the alternative E+ version adds to your
Effects palette no less than 150 thumbnails, sorted by
category.

Of course, the scripts are more powerful than the actions.
However, the action-based interface lets you access most of
the E+ essential features.

Furthermore, the effects from the 9th through the 19th
categories let you run scripts from E+ catalog (or, to be
precise, those of them that don't open script dialogs).

To install the action-based version go to the
"C:\Elements+\15.0\" folder, launch the "e+15a_setup.exe"
file and wait until PSE rebuilds its cache.

Important! Please do not uninstall the standard (script-
based) version of E+, because its files are required for the
action-based set.

To access the E+ functions:

1. In the Effects panel, open the "Photo Effects" tab.

2. In the drop menu, choose one of the "numbered" E+
categories (screenshot 1).

3. To apply a function, either double-click its thumbnail
(screenshot 2) or drag it onto the target image window.
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